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CL800O0 Label Printing Scale

Thank you for your purchase.

For the proper using & maintaining the scale please read this
instruction completely before operating.
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1. GENERAL
1.1. PRECAUTION

A Warning Precautions when installing the scale. To ensure that you get the

most from your scale, please follow these instruction.

Do not disassemble the scale.

When any damage or defect occurs, contact your
CAS authorized dealer immediately for proper repair.

Do not overload beyond the maximum weight limit.

Scale must be grounded to minimize electricity static.

This will minimize defect or electric shock.

Do not pull the plug by its cord when unplugging.

Damaged cord could cause electric shock or fire.

To prevent from fire occurring, Do not place or use
the scale near flammable or corrosive gas.

To reduce electric shock or incorrect reading,
Do not spill water on the scale or place it in
humid condition.

A2 s T

A o
e g
<@

Avoid placing the scale near heater or in direct sunlight.
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Insert plug firmly to wall outlet to prevent electric shock.

A Attention makesureto plug your scale into the proper power outlet.

For maximum performance, plug into a power outlet 30 minutes before the usage for warm up.

For consistent and accurate reading, maintain
periodical check by your CAS authorized dealer.

Avoid sudden shock to the scale.

Grab on the bottom of the scale when moving.

Keep the scale away from other electromagnetic
generating devices.

This may interfere with accurate reading.

Place the scale on firm and temperature consistent
environment.

By adjusting 4 comers of the scale, set the scale
even using the built in scale leveling indicator.
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1.2. INTRODUCTION

Thank you for purchasing CAS CL8000 series.

CL8000 is a PC-based price computing electronic scale. We have integrated intuitive and
powerful functionalities in its design to address the needs of users in various
applications, and we are confident that CL8000 will make operating your business easier.
Remember, for proper installation and maintenance please have your CAS authorized
dealer do the primary installation, programming, and demonstration. Your CAS
authorized dealer also has a wide variety of supplies, accessories, and expansion
options for whatever your new and increasing demands may require. Authorized CAS
dealers are trained to help you with every aspect of the CL8000 series and should you
need servicing, they are highly trained by CAS to assist you with virtually any problem.

eIncluded Accessories

Power Cable Installation Guide Load Tray GND Wire

10
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1.3. SPECIFICATIONS
Max. Capacity 3/6 kg 6/15 kg 15/30 kg
Interval 1/2g 2/5g 5/10g
Max. Tare -2.999 kg -5.998kg -9.995 kg

Approx. 8 times / s

Measurement Type

‘ Operating Temp.

Load cell
-10°C ~ 40°C (14°F ~ 104°F)

Power

Printing Rate

AC 100~240V 50/60Hz 1.5A
Max. 150 mm/sec

Printing Resolution

202 dpi
Width: 40 mm ~ 60 mm / Length: 30 mm ~ 200 mm

‘ Label Size
Printer Type

Direct thermal print

o System
Intel® Celeron™ J1900 (2.0 GHz) Quad-Core Processor / Fanless
CPU
(Standard)
Chipset Intel® Bay Trail
Storage PCA, PCB type : SATA 2 (3Gb/s) 2.5 inch SSD 64GB, Support AHCI

B, U, SU type : mSATA SSD 64GB

System Memory

4GB Standard (Type: DDR3L, Socket 1 x SODIMM)

‘ Graphics Integrated Intel HD Graphics
Sound Realtek ALC662-VD 5.1 CH Audio
« Display
S/ PCA, PCB type : 15" TFT LED backlight, 9.7” TFT LED backlight
vl B, U, SU type : 10.1" TFT LED Backlight, 7" TFT LED Backlight
Resolution PCA, PCB type : 1,024 x 768
B, U, SU type : 1,024 x 600
. 2
B e PCA, PCB type : 300 cd/m? (typ.)

B, U, SU type : 10.1” = 180 cd/m? (typ.), 7” = 350 cd/m? (typ.)

11
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e Touchscreen
Type Projective capacitive touch
Interface USB

« /0 Interface — PCA type

Video Out 1 x VGA (with 12V power output)
‘ USB Port 6 (Rear 2, Back 4 / USB 2.0 x 6 Ports
‘ 5 (COM1 with 5V/12V Power Output on 9 Pins, BIOS)
(COM2 ~ 3 RJ-45, full signal)
Serial Ports (COM4 RJ-11, Only TX/RX, 12V power output)
(COMS5 Reserved)
(COM®6 RJ-45, Only TX/RX, 5V Power Output)
" LAN 1 x gigabit ethernet, RI-45
| Audio Out Line-out
 Power AC 100~240V 50/60Hz 1.5A
0s Windows 10
«1/0 Interface — PCB type
Video Out 1xVGA
‘ USB Ports 3x /0O panel, 2 x left side, 1 x right side(MSR)

Parallel Ports

1*LPT

‘ Serial Ports 4 DB9 (only COM4 5V/12V)

‘ LAN 1 x 100 Megabit ethernet, RJ-45
‘ Audio In/Out Line-in, Line-out

 Power AC 100~240V 50/60Hz 1.5A
0s Windows 10

12
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«1/0 Interface — B, U, SU type

USB Ports

6(USB3.0x1/USB2.0x5)

Parallel Ports

2(COM1, COM4 full signal)

1(COM 3 with 5V/12V power output on 9 pins, factory setting)

" LAN

1 x 100 Megabit ethernet, RJ-45
* Audio Out Line-in, Line-out
‘ Power AC 100~240V 50/60Hz 1.5A
- 0s Windows 10

e Instrument & Environment

Color Dark gray
Load Tray Size 368 x 288 (mm)
PCA, PCB type : 399(W) x 447 (D) x 631(H)(mm)
B-Type : 399(W) x 450(D) x 171(H)(mm)
Dimensions U-Type : 399(W) x 485(D) x 578(H)(mm)

SU-Type : 399(W) x 485(D) x 292(H)(mm)
* Height: excluding rear LCD

Note: Some of the specifications may change without prior notice.

13
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1.4. DIMENSIONS
« PCA type

=
™)
368 —
—
2
o =
Q0|
399

673
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« PCB type
= T n T
;I ok
399
B type
[ 1
399
« U type
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609

494

211

e |
171

399

S

578 \

)

« SU type

il [
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399

.
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15. SETUP

1.5.1. Basic Setup

« PCA type

17
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« PCB type

« B type

18
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o U type

« SU type
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1.5.2. Rear Display Assembly

« PCA type

20
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1. Unmount rear cover of the 2. Insertthe rear display in the 3. Run the rear display cable
main display. arrow’s direction {make sure the through the opening.
cables are inserted first).

4. Connect the rear display cable. 5. Reassemble the rear cover,
then make sure no cables are
stuck under the rear cover.

« PCB type

21
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Screws

1. Insert rear display hook into 2 Rear display hook
the main display’s sockets.

3. Onca the rear display hooks 4, Connect the communications
areinserted into the sockets, and the power cables as is shown.
tighten the screws.

1.5.3. Installation of the Label Roll

22
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e Label Specifications

Outer Diameter: 100mm

Inner Diameter: 40mm

Receipt Roll Width: 40, 50, 60mm
Label Roll Width: 64mm (max.)

Width

A

Inner Diameter
(40mm)

A A

Outer Diameter
(100mm)

e Printable Area

Label Width: 56mm (max.)
Label Length: 200m (max.)

Label width (60mm)
Print Area (56mm)

'Y

|2
iJL

\¥/—\

T T 4 taveramp

Label length
(Max 200mm})

e Please install the label roll in the following order:

1) Pull the front handle to open the front door.

23
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2) Insert the roll into the label supplier pole, then mount the roll.

/ REWINDER BUSH

LABEL GAP SENSOR

LABEL

\ LABEL SUPPLIER POLE

TPH SETTING LEVER

* Turn the TPH lever to open, run the label through then hang the label’s end onto

the rewinder bush.

3) Hang the label’s end onto the rewinder bush, then rotate the level to tighten the

label.

24
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4) Return TPH setting lever to its original position then close the door.

25
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5) Adjust the label (see below), then pull the TPH down.

LABEL

| —=n | /7 GAP

= O
LABEL

| —=n | /7 GAP

GOOD Q

6) Press “Feed” Key.

e If the label is out of position, please check the following:

a, Set the label size
b. Adjust the roll position
c. Set the sensor

26
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1.5.4. Power On/Off

1) Booting

1. Turn on the switch on the lower side of the scale.

AC Power Fuse  Power Switch

27
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2. Press the monitor’s power button as in the picture below.
* Power button is on the bottom right corner of the monitor.

« PCA type

« PCB type

28
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3. Check to see if the windows have booted up normally.

kg  WEIGHT

0.000

A Fruit BEcsRIEIERg

0%
T

Banana

kg UNIT PRICE $/kg | TOTAL PRICE $

0.000

Cherrie

000  0.00

Choose Item

Watermelon

Pineapple

14.'

15 ¢ ‘
‘ DISC(:) DISC(%)

Green apple ADD  STITTL

17

iy

Blacberry

Raspberry

Grapefruit Coconut

Max. 6/15kg Min. 40g e=d=2/5g (i) L)

24

>

15-10-21 09:13

Once booted normally, the windows display “Tare/Weight/Unit Price/Price” on the

29
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upper side of the screen.

30



CL8000 Label Printing Scale

TOTALWEIGHING SOLUTION™

2) Shutting Down

It is recommended that the windows is shut down from the O/S menu for system

stability.

Please close all applications before shutting down the windows.

@ Press monitor’s power button
@ Click “Power Off” to shut down.

I\ Power Off
The system will powe

Power Off

31
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2. SALES OPERATION

2.1. STANDARD SALES OPERATION

2.1.1. Sales operation - General type
- Sales operation in the case of ‘General type’ keypad layout
- Refer <3.6.4.1> Keypad Layout Type

2.1.1.1.  Selling Weighed Products

1) select the category (if you need to change the category)

g g O
0.000 0.000 .00
% Fruit
2 3 e | 5
& locjae| @
Apple ‘Banana Avocado Cherrie Watermelon
1 m 13 14 o 15 j‘
« | do | B
s d
Melon Pineapple Lemon Peach Green apple O
16 17 18 19 20 .
o dite| iy | S JEEE
RID PA
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 5 23 24 25
O Y e ) Bac
— 7/8]9
Grapefruit Coconut Grapes Orange Mango
i 00( 0| C

32
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kg WEIGHT kg UNIT PRICE $/kg " TOTAL PRICE $

0.000 0.000 () 0.00

(r— g Choose ltem

"

Brocoli Potatoes

11

Max. 6/15kg Min. 40g e=d=2/5g (iD) @/ 15-10-21 09:13

2) Select PLU of the product (weighed product).

If the product is on the next page, you can move the page. (swipe available)

R g g PR $/kg O PR 3
U.00( 0.000 V.00 U.0(
% Fruit
2 3 I C AN 5 7 0039 =
&locjde| @
Apple g Banana Avocado Cherrie Watermelon
1 % 13 14 o 15 ‘
- d
Melon Pineapple Lemon Peach Green apple 0 oD S
16 -l 17 18 19 o 20
RID
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 ‘ 23 247 ' 25| 4 5 6 e
e & i 71819
Grapefruit Coconut Grapes Orange Mango
00| 0]|C
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kg  WEIGHT kg  UNIT PRICE $kg " TOTAL PRICE $

0000  0.000 000 000

2 o = Choose Item
4 7/ ‘ =
Lime Papaya Durian

|

Max. 6/15kg Min. 40g e=d=2/5g ( : 15-10-21 10:38

3) Put the product on the scale.

AR g g PR $/kg OTAL PR
0.000 0.000 9Y 0.00
S = Avocado
2 3 ) 4 A 5 4 Product ID : 3
| o l@e @ e
T Packed Time
Apple Banana Avocado Cherrie Watermelon
1 - 14 o 15 ‘
V\;;o—n Pineapple Lemon Peach Green apple 0 DD
16 17 = 18 19 20 2.
RID
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 y 23 24 25
Pt Fe ) Ban =
R 71819
Grapefruit Coconut Grapes Orange Mango
e 00/ 0| C
g 0g e=d=2/5g B 0 0

34
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4) when the weight value is stable, press ‘print’ to sell

3 Fruit
2 3 -
Alee
Apple Banana Avocado Cherrie Watermelon
1 13 > 14 o 15 .‘
U [es|e (3| ¢ B
Melon Pineapple Lemon Peach Green apple B .
16 17 18 !l 19 I 20' o =
Strawberry Kiwi Pomegranal‘e Blacberry Raspberry 1 2 3
21 23 24 25
, 456
L @ LEed
P 71819
Grapefruit Coconut Grapes Orange Mango
W oojo|cC
2.1.1.2.  Selling Counted Products
1) select the category (if you need to change the category)

% Fruit
2 3 4 N5 7 o
. O
Apple Banana Avocado Cherrie Watermelon
11 m 13 14 o 15 ‘
\ oo |38 §E
Melon Pineapple Lemon Peach Green apple n o
16 17 18 19 20
Strawberry Kiwi Pomegranate |  Blacberry Raspberry 1]|2 3
21 23 24 25 4 5 6
%4k @ L5 ed
D\
7(8]9
Grapefruit Coconut Grapes Orange Mango
sl 00 [ C
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2) Select PLU of the product (counted product).

AR o 0 PR i o PR
D Banana
2 3 ] 4 A 5 (7F Product D : 2
Produced Date
p & -
ey Packed Time Duration ; 10:42
Apple Banana Avocado Cherrie Watermelon
1 13 14 o 15 ;‘
O S| (3| ¢ B
@1 Pineapple Lemon Peach Green apple AUTO DD
16 17 18 19 20
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 23 24 25,
ON‘ (&) ‘ 3 4 5 6 ED
R 71819
Grapefruit Coconut Grapes Orange Mango
e 00| 0| C
g 40g E 0:4
. . “ 9
3) Key in number of units, then press "PRINT  to sell the product.
AR 0 PR o PR
0.000 U 0 U
(il Banana
2 3 14 A 5 7% Product D 2 S
Produced D
s Packed Time Duration - 10-42
Apple Banana Avocado Cherrie Watermelon
11 13 14 o 15 '
O Q| T (3| ¢ I
NE;n Pineapple Lemon Peach Green apple A 0 A ADD
16 17 18 19 20 .
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 23 24 25,
L @, | e
e~ 71819
Grapefruit Coconut Grapes Orange Mango
00| 0| C
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2.1.2. Sales operation - Full type
- Sales operation in the case of ‘Full type’ keypad layout
- Refer <3.6.4.1> Keypad Layout Type

2.1.2.1.  Selling Weighed Products
1) select the category (if you need to change the category)

g Fruit
1 2 3 4 | 5 7T 11 =
Hocidel @ | @
Apple Banana Avocado Cherrie Watermelon Melon Pineapple
13 14 o 15 ‘ 16 - 17 18 19
Lemon Peach Greenapple | Strawberry Kiwi Pomegranate |  Blacberry
20 " 2 23 24 25 26 Y
=/ 8 Q P &
Raspberry Grapefruit Coconut Grapes Orange Mango Plum
27 ! 28 29‘ 30 >
<l g £ "v,
Pear Lime Papaya Durian
Q

kg WEIGHT ko 'UNITPRICE kg 'TOTALPRICE  §

0.000 0.000 0.00 0.00

ﬁ 9 10
L -
S W P
NS ! 3 JK;& ‘
Brocoli Potatoes Pepper

Q

Max. 6/15kg Min. 40g e=d=215g (D ¥ 15-10-2110:59
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2) Select PLU of the product (weighed product).

S Fruit
2 & 3 x| @ [ % )
. ’ % (
Apple Banana Avocado Cherrie Watermelon Melon Pineapple
13 14 o ' 15 . lw-ilﬂ i 18!| 19 I
Lemon Peach Green apple Strawberry Kiwi Pomegranate Blacberry
20 B | 21 3 23 24 25 26 Y
Y6 @ e -
Raspberry Grapefruit Coconut Grapes Orange Mango Plum
27 ! 28 29“ 30 ﬂ
ik 4 £ | 2
Pear Lime Papaya Durian
Q

kg  WEIGHT kg UNIT PRICE $/kg " TOTAL PRICE $

0.000 0.000 15.50 0.00

pack DISCH) DISC(%)

OVER MiISC MisC MISC
RIDE WEIGHT COUNT PCS
Product ID : 1

Produced Date :

Packed Date Duration : 15-10-21

Packed Time Duration : 11:00

Max. 6/15kg Min. 40g e=d=215g (i) &
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3) Put the product on the scale.

kg  WEIGHT kg UNIT PRICE $/kg TOTAL PRICE $

0.000 0.232 15.50 3.60

Apple MISC  MISC
WEIGHT COUNT
» ProductID : 1

» Produced Date :

« Packed Date Duration : 15-10-21

«» Packed Time Duration : 11:01

Max. 6/15kg Min.40g e=d=2/5g (iil U} 15-10-21 11:01

4) when the weight value is stable, press ‘print’ to sell

kg  WEIGHT kg UNIT PRICE $kg " TOTAL PRICE $

0.000 0.232 15.50 3.60

DATE
ADD ST/TTL TIME

PRE
PACK
Apple MISC | MISC  MISC
WEIGHT COUNT ~PCS

DISC(-) DISC(%)

« Packed Date Duration : 15-10-21 4 FEED

» Packed Time Duration : 11:01

PRINT

» Product D : 1
1 PLU
» Produced Date :

Max. 6/15kg Min. 40g e=d=215g (iy &/ 15-10-2111:02
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2.1.2.2.  Selling Counted Products

1) select the category (if you need to change the category)

AR a = PR $/ka o PR
0.000 0.00( .00 .00
3 Fruit
2 3 R £ A 5 7% 11 - =
‘*&' .@ @ : %
Apple “Banana Avocado | Cherrie Watermelon Melon Pineapple
13 14 o ' 15 ‘ 116 17 i 18 !I 19 I
Lemon Peach Green apple Kiwi Pomegranate Blacberry
20 = (i 23 24 25 EIN
@ |2 9 &
oo |2ue [
Raspberry Grapefruit Coconut Grapes Orange Mango Plum
27 ! 28 29 ‘ 30 ﬁ
@ O o
Pear Lime Papaya Durian
Q
0g e=d v 0-2110
2) Select PLU of the product (counted product).
AR g g PR $/kg OTAL PR
0.00( 0.000 .00 .00
S Fruit
1 2 3 4 A 5 ¢ 11 « S
: ‘*&’ e @ ! m
Apple &Banana Avocado Cherrie Watermelon M—eal Pineapple
13 14 o 15 1‘ T 16 18 19 |
L3¢ | sy
Lemon Peach Green apple Pomegranate Blacberry
20 g |2 25 E
P@ | = P &
B\
Raspberry Grapefruit Coconut Mango Plum
27 ! 28 r 29‘
s.l & 48V
Pear Lime Papaya
Q
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3) Key in number of units, then press “PRINT” to sell the product.

Banana

= ProductID:2
» Produced Date :
» Packed Date Duration : 15-10-21

» Packed Time Duration : 11:03

Max. 6/15kg Min.40g e=d=215g (D ¢/

15

Banana

= ProductID : 2
« Produced Date :
» Packed Date Duration : 15-10-21

» Packed Time Duration : 11:03

Max. 6/15kg Min. 40g e=d=2/5g (i) ¢/

UNIT PRICE

$/kg

5.50

TOTAL PRICE $

9.50

OVER MISC  MisC
RIDE WEIGHT COUNT

PLU

X FEED

UNIT PRICE

>0< TARE

AUTO

FOR

PRINT

15-10-21 11:03

TOTAL PRICE $

82.50

$/kg

5.50

DATE
ADD STITTL TIME

PRE
pack DISCL) DISC(%) .

SAVE

OVER
RIDE

MISC MiSC MisC
WEIGHT COUNT PCS

15-10-21 11:03
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2.1.3. Using Product Search Function
1-1) You can select the product by clicking the search button.

g g PR $/kg OTAL PR
0.000 0.000 .00 .00
o Fruit
2 3 ~ 14 AN 5 7T S AL
. @s) @
Apple .Banana Avocado Cherrie Watermelon
1 < 13 14 o 15 j'
' % o 3 v B :
r:(;o—n Pineapple Lemon Peach Green apple 0 ADD
16 17 18 19 20 "
RID
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 k 23 24 25
o[ W@ e Lk
§ &
R 7189
Grapefruit Coconut Grapes Orange Mango
g 00| 0| C
40g 0
R g g PR $/kg O PR
S Fruit
2 3 14 N\ R 1 Ty
s G @ ' %
< pa—
Apple Banana Avocado Cherrie Watermelon Melon Pineapple
13 14 o 15 ‘_‘ 18 19
1o (BB @ e i
Lemon Peach Green apple Pomegranate Blacberry
20 ” 21 23 24 25 26 Y
Sae P @
D\ T —
Raspberry Grapefruit Coconut Grapes Orange Mango Plum
27 ! 28 29 ‘ 30"
oy | & -
Pear Lime Papaya Durian
Q
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1-2) You can either select the product from product list, or find it through the search

button. You can search the entire list of categories if you use the search function in the

Category screen.

Apple
Banana
Avocado
Cherrie
Watermelon
Brocoli
Carrots
Cilantro
Potatoes

Pepper

Watermelon

aff Q

Potatoes
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DL Watermelon
2 3 4 @by 5 70 Product D : 5
5 " Produced Date
4 & PackedDae Duzon: 151021
e Packed Tame Duration : 11:08
Apple Banana Avocado Cherrie Watermelon
1 % 13 14 o 15 ‘
- ; S 1 0
e ” -
Melon Pineapple Lemon Peach Green apple : —
16 17 18 19 20 -
RID
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 23 24 25, 4 5 6 -
ou g & | T8 ed
Grapefruit Coconut Grapes Orange Mango
e 00/ 0| C

2.1.4. Add Sales

This function usually is used when the each product is packaged in a bundle.

1) Select the item, press “add”.

AR R - 0 PR
S Fruit
2 4 AN s 7
.
Apple Banana Cherrle Watermelon
1 - 13 14 o 15 ‘
h};o—n Pineapple Lemon Peach Green apple o S DD
16 17 18 19 20 Ren
RID
Strawbery Kiwi Pomegranate |  Blacberry Raspberry 1 2 3
21 ‘ 23 24 - 25, | ' 4 5 6 —
T i 71819
Grapefruit Coconut Grapes Orange Mango
00| 0| C
40g 0
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R g g R g (@) R
V.000 U U ol
L Fruit Apple
2 3 4 N\ OVE
50 Wl
b ¢ Packed Time Duration : 15:04
Apple Banana Avocado Cherrie Watermelon
11 Ty 13 14 o 5 _i4
! %@ A ” 3 ;
M_e.;n Pineapple Lemon Peach Green apple DD
16 -l 17 18 ! | 19 | ﬂ ’
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 23 24 25
o e OF) DBo=
——— 7(181]9
Grapefruit Coconut Grapes Orange Mango
e 00] 0| C

2) As the label is printed, the item is added on the list

- to keep selling item, click Exit button and go back to sale state.

Apple

I

0,000

15-10-21

1550

CAS

010-1234-567
Scale Mart 2

[ Printed label after the add sale ]

¥
308
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Sales History

Product Name Unit Price

1 0.232%kg 15.50 § 3608

Number Of Product : 1Case 11 Total Price : 3.60 $

T 0 0 I

Sell Total Print

15-10-21 15:04

[ Sale screen after the add sale ]

3) As the label is issued, the product is added to the list.

Fruit ege
S Banana
2 3 4 | 5 7% Product ID : 2
: - : Produced Date
VA ‘ Packed Date Duration : 15-10-21
-8 Packed Time Duration : 15:04
Apple Banana Avocado Cherrie Watermelon
11 " 13 14 o 15 1‘
—_—
Melon Pineapple Lemon Peach Green apple A 0 A ADD
16 17 18 19 20 ”
RID
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 23 24 25, 4 5 6
D
2| @ (W[ 509
¢ [
—
71819
Grapefruit Coconut Grapes Orange Mango
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g O $/kg OTA 5
U.000 o U 9.00
it Banana
2 3 4
» ‘&’ L
Apple \Banana Avocado Cherrie Watermelon
11 2 13 14 o 15 ‘
O [RGE [
Melon Pineapple Lemon Peach Green apple
16 17 m!| 19.I 20'4_H
Strawberry Kiwi P:)megranale Blacberry Raspberry 1 2 3
21 23 24 25,
| Y e ) Bac
. 71819
Grapefruit Coconut Grapes Orange Mango
| 00| 0 | C

4) As the label is issued, the product is added to the list.

The item is added on the list

You can see the total information about the items which is on the list.

To print the information, which is added to up to now, click the ‘sell total print’ button.

when subtotal is printed, the list is initialized.

Banana

"

CAS

010-1234-5678
Scale Mart

[ Printed label after the add sale ]
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Sales History

Product w ;m

s Unit Price

Product Name:

2

Banana S8EA 650§

Apple 1 0.23%g 1550 360§

Number Of Product : 2Case  1/1 Total Price : 322.60 $

Delete All o ° Sell Cancel

15-10-21 15:04

[ Sale screen after the add sale]

g sub Total }

VOID COUNT TOTAL COUNT

](\IN WI ]()IM IAX PAYMENT PRICE  CHANGE §

[ After the sell total ]
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2.1.5. Change keypad settings on the sales mode
2.1.5.1.  Change a product keypad settings
- You can set Product keypad settings directly on the sales screen
This function operates only when Keypad Arrangement Method is ‘MANUAL in
<3.6.4.4> Keypad Config.
1) If you press a product keypad for 3 seconds, the keypad setting window pops up.

If you change the setting, it is applied immediately to the sales screen.

3 Fruit
2 3 N C N R i =
A locide] @
Apple i Banana Avocado Cherrie Watermelon
11 % 13 14 o 15 .
‘ k| Lo [ BB | &
M—su;l Pineapple Lemon Peach Green apple ol 5
16 17 18 T 20
o ofts] oy | Sw [T
Strawberry Kivd Pomegranate Blacberry Raspberry 1 2 3
21 23 24 25,
s @ Lo e
N
Grapefruit Coconut Grapes Orange Mango 7 8 9
e 00| 0 | C
:
[Before]

skqg "TOTAL PRICE

[ 2 .
PLU NO. Name Nickname
Apple.
r— FontSize | 16
Avocado

sanicon ([
Cherrie

Watermelon Background

X
Melon Eolor

Pineapple
Leman

Peach
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[Change Product]

Keypad Arrangement

PLU NO. Name Nickname

B

! Apple
2 Banana Font Size 16 .
3 Avocado

Font Color .
4 Cherria
5 Watermelon Background

Color x
n Melon

I 12 Pineapple | :
2 Lemon () &m %@
" Peach Pineanpie
Guest

PROGRAM MODE > Setup > Keypad > Keypad Arrangement

3 Fruit
2 3 4 0 € 00 =
Aople Banana Avocado Cherrie Pineapple
1 T 13 14 o v _iQ
! “ -« ‘ 3 '
l;e_h—ﬂ Pineapple Lemon Peach Green apple 5 5
16 )€ i 18 !I 19 I 20 '
Strawberry Kiwi Pomogranate Blacberry Raspberry 1123
7 2 2 25
'S, = oan=
2ue 1.5 -ha
i 71819
Grapefruit Coconut Grapes Orange Mango
R 00 0] C

[After]

2.15.2.  Change a function keypad settings

- You can set function keypad settings directly on the sales screen
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1) If you press a function keypad for 3 seconds, the keypad setting window pops up.

If you change the setting, it is applied immediately to the sales screen.

kg WEIGHT kg UNIT PRICE $kg TOTAL PRICE $

0.000 0.000 0.00 0.00 |

Choose Item

15-10-21 12:27

UNITPRICE kg TOTAL PRICE

Key
DISCOUNT 1

Font Size 18
DISCOUNTPER 2

func_specialPrice
Font Color
FIXD
TYPE Background
Color
MISC WEIGHT
MISC COUNT

MISC PCS

UNIT1

[Change Function]
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Key

DISCOUNT 1
Font Size
DISCOUNTPER 2
func_specialPrice 3

FIXD

TYPE

Background
Color

MISC WEIGHT
MISC COUNT
MISC PCS

UNIT1

15-10-21

kg WEIGHT kg UNIT PRICE $kg "TOTAL PRICE $

0.000

0.000

0.00

0.00

Choose Item

Watermelon

Lemon

Green apple

Pomegranate

e

DISC() DISC(%)

TYPE STITTL

PRE

pack PLY

=y

Grapes

Max. 6/15kg Min. 40g e=d=2/5g (i) ¢/

*

[After]

15-10-2112:32
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3. PROGRAMING

- Each menu in PROGRAM MODE is usable only with an account which meets its

required

How to access the menu.

1) On sale screen, press gear shape icon at the top right to move to the program mode

(The first screen of program mode is BOOKMARK menu)

TARE kg WEIGHT kg  UNIT PRICE $kg ' TOTAL PRICE $

= 0.000 0.000 0.00 0.00 ,

Choose Item

>0< TARE DISC(-) DISC(%)]

AUTO SAVE ADD STITTL

OVER PRE

RIDE Pack PLU

7

Max. 6/15kg Min. 40g e=d=2/5g (i) &/ 08-08-2110:53

= | BOOKMARK

PROGRAM MODE > BOOKMARK 08-09-21 10:56
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Readable / Modifiable levels.

- Logging in with a user account will enable reading and modifying of the menu which

meets.

Readable / Modifiable levels of the account.
- Not logging in with any account will assign the user Guest levels.

(Please refer to 3.4.2 Store - User & Security for user levels.)

= | BOOKMARK
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= BOOKMARK

admin

3.1. BOOKMARK MENU

- Bookmark menu can be used to store frequently accessed menu.

1) Click in the following order: BOOKMARK.

X CL8000 PROGRAM MODE

M BOOKMARK
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2) How to add a bookmark: Click the “¥%” on the submenu of your choice to add it to
the bookmark list.

- Active bookmarks are highlighted blue.

- Click the “¥¢” again to remove the submenu from the bookmark list.

X CL8000 PROGRAM MODE

PLU

Department

Tax

Sales Message
Origin

Barcode

Tare

Quantity Unit Symbol
Ingredient

Country

Traceability

3) Bookmarking a submenu will display the added submenu in the bookmark list,

enabling a quick revisit. (Pressing “x” will remove the submenu from the bookmark list)

BOOKMARK

Data ) PLU

56



CL8000 Label Printing Scale

TOTALWEIGHING SOLUTION™

3.2. DATA MENU
3.2.1. Data — PLU

- This menu is for generating, modifying and deleting product data.

Gmup

Origin

Barcode

X CL8000 PROGRAM MODE

Department

Sales Message

Quantity Unit Symbol

3.2.1.1.  Create New PLU
1) Click “New” button.

= | P

PLUNo. « Short Code »  PraductType
1 28 COUNT
2 WEIGHT
3 WEIGHT
4 WEIGHT
5 WEIGHT
[ WEIGHT
7 WEIGHT
B WEIGHT
9 WEIGHT
10 WEIGHT
un WEIGHT

bell-pepper

bread
Perilla leaf

Apple

Banana
Fine apple

Sweet Potato

Unit Price.

20200811 1:26
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2-1) PLU No. is automatically set to the next number.

Department No. 1. default

I PLU No. 1u I

PLU Type @) WEIGHT || COUNT

Category Select

o

Packed Date

PROGRAM 8ODE » Data » PLU

2-2) If PLU No. does not exist, you can create a new one.

If the PLU No. exists, a pop-up window appears whether to load the existing

information.
= PLU
Department No. 1. default
| PLU No. 1 |
PLU Type ® WEIGHT COUNT PCs
Unit Price 0.00
Name
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The product already exists.
Do you want to get that information?

| S

PROGRAM MODE > Data > PLU

Department No. 1. default
| PLU No. 1
PLU Type WEIGHT PCS
Unit Price 155
Name Apple
Name2
Name3
Category 1. Fruit
Item Code
Load Image

08-09-21 11:31
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3) Click the filed to insert the information using on-screen keyboard.

PLU Type

1. default

un

@ WEIGHT COUNT

Unit Price

Name

4) Click “Load Image” button to assign a product image.

(Product images can be transferred via CL-Works Pro)

Named

Category

Shart Key

Item Code

Image

Packed Date

Packed Time

PPacked Time Static

Sell By Date

Sell By Time

Category
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x ‘
B

L 1O m . @ e
| B ol | B | el]
e 4 | -

& 25 § = J
2k A e | O ;

0rapes2 jpg

breadpg coconutipg grapespg

Name banana

Category 1. Fruit s

[x]
- -
Ah

PROGRAM MODE > Data > PLU 08-08-21 11:41
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5) Type in necessary and additional data of PLU No., PLU Type, Unit Price and Name1l,

then save.
| = |
Department M. Default =+
PLU No. 10001 H
PLU Type @) Weight Count
Unit Price 105
Namel apple
Name2
Name3
Named
NameS
Name6
Name7

3.21.2.  Modify PLU
1) Click a PLU to begin modification.

ProductType
COUNT
2 WEIGHT avocado n
3 WEIGHT banana 5
4 WEIGHT beef 5
5 WEIGHT bell-pepper 5
6 WEIGHT bread 15
7 WEIGHT Perilla leaf 30
8 WEIGHT Apple 31
9 WEIGHT Banana 0
10 WEIGHT Fine apple 2
un WEIGHT Sweet Potato 12

PROGRAM MODE > Data > PLU Gues 2020-08-11 11:27
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2) Modify PLU data, then press “Save” button.

PLU No.

PLU Type

Unit Price

Delete

Department No.

Default B

1

Weight (@) Count

150

apple

Name3

Named

Name5

Name6

Name7

PROGRAM MODE > Data = PLU

3.2.1.3. Delete PLU
1) Click the PLU which needs to be deleted.

PROGRAM MODE > Data > PLU

“ 1. default : ALL s
PLUNo. » PLU Type Name « Unit Price

1 COUNT Apple 155 S
2 WEIGHT Banana 5.5

3 WEIGHT Avocado 5.99

4 WEIGHT Cherrie 5

5 WEIGHT Watermelon 5

6 WEIGHT Brocoli 8.99

7 WEIGHT Carrots 20

8 WEIGHT Cilantro 21.25
9 WEIGHT Potatoes 10

10 WEIGHT Pepper 2

280421 1057
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2) Click “Delete” button to delete the selected PLU.

Delete I
No.

Department Default s

PLU No. 1 S
PLU Type Weight (@) Count

Unit Price 150

Namel apple

PR E

PROGRAM MODE > Data > PLU
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PLU

10

PROGRAM MODE > Data

WEIGHT

Banana

Avocado

Cherrie

Watermelon

Brocoli

Carrots

Cilantro

Potatoes

Pepper

Unit Price

599

280421 12

3.214. PLU List

1) Enter PLU menu to see a PLU list.

PLU
2 WEIGHT avocado
3 WEIGHT banana
4 WEIGHT beef
5 WEIGHT bell-pepper
6 WEIGHT bread
7 WEIGHT Perilla leaf
8 WEIGHT Apple
9 WEIGHT Banana
10 WEIGHT Fine apple
1 WEIGHT Sweet Potato

15

31
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2) Search the Department

1. default ® “
defauit
Name - Unit Price

2. fish

3. fruit Apple 15.50 B
2 WEIGHT Banana 5.50
3 'WEIGHT Avocado 5.99
4 WEIGHT Cherrie 5.00
5 'WEIGHT Watermelon 5.00
[ 'WEIGHT Brocoli 8.99
7 WEIGHT Carrots 20.00
8 WEIGHT Cilantro 21.25
9 'WEIGHT Potatoes 10.00
10 WEIGHT Pepper 2.00

PROGRAM MODE > Data > PLU

3) Search the PLU by typing PLU No. or Name in the searching field.

PLU

PLU Type Unit Price
2 WEIGHT Banana 55
3 WEIGHT Avocado 5.99
4 WEIGHT Cherrie 5
5 WEIGHT Watermelon 5
3 WEIGHT Brocoli 8.99
7 WEIGHT Carrots 20
] WEIGHT Cilantro 2125
9 WEIGHT Potatoes 10
10 WEIGHT Pepper 2
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PLU No.

PROGRAM MODE » Data

PLU Type

>PLu

Name

Banana

Unit Price

4) PLU No., Short Code and Product Name fields can be clicked to arrange the items per

the selected field.

PROGRAM MODE > Data > PLU

WEIGHT

WEIGHT

WEIGHT

WEIGHT

WEIGHT

WEIGHT

WEIGHT

WEIGHT

B Name
Name «
Apple
Banana
Avocado
Cherrie
‘Watermelon
Brocoli
Carrots
Cilantro
Potatoes

Pepper

Unit Price
155
5.5
5.99

5
5
8.99
20
2125

10

280421 12:

S

10
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3.2.2. Data — Department

- This menu is for generating, modifying and deleting a query of department data

X CL8000 PROGRAM MODE

PLU

Group

Sales Message
Origin

Barcode

Quantity Unit Symbol

1) Delete Department
(Please note that Department No. 1 is undeletable)

*Caution: Deleting a department will also delete all PLUs in the department

Alarm

Delete this Data?
Department No.1 Related data -> 1
Product(s)

(You can’t recover deleted data)

PROGRAM MODE > Data > Department Guest 08-09-21 14:24

68




CL8000 Label Printing Scale TOTALWEIGHING SOLUTION™

3.2.3. Data — Group

- This menu is for generating, modifying, deleting and querying Group data

x CL8000 PROGRAM MODE

PLU

Department
[0 oo

Sales Message

Origin
Barcode

Quantity Unit Symbol

3.24. Data — Sales Message

- This menu is for generating, modifying, and deleting Sales Message data

x CL8000 PROGRAM MODE
PLU

Department

Group

7 Sales Message

Origin

Barcode

Quantity Unit Symbol
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3.2.5. Data — Origin

- This menu is for generating, modifying, and deleting Origin data

X CL8000 PROGRAM MODE

PLU

Department

S

Sales Message

Barcode

Quantity Unit Symbol

PROGRAM MODE ) D

3.26. Data — Barcode

- This menu is for generating, modifying and deleting Barcode data

x CL8000 PROGRAM MODE
PLU
Department
EEEN -
Sales Message

Origin

Quantity Unit Symbol
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3.26.1. Create New Barcode
1) Click “New” button.

= Barcode

Barcode No. Barcode name Barcode Type Barcode formNo Barcode format

1 bacode1 1 1 DDINIPPPPPC =

2020-07-31 10:17

2) Type in Barcode No. and Name, then set Barcode Type.

— Barcode

Barcode No. 2
Barcode name test &
| Barcode Type select I
salect
Barcode formNo
Barcods format 2. EAN13A5
3. EANS

4.120F5

6. UPCA

6. UPC13

7. CODE39
8. CODES3
9. CODE128
10. CODEBAR Shif next
11. GS1_OMNIDIRECTIONAL :
12. GS1_STACKED

Enter

v
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3) Once the Barcode Type is set, choose a format from the list or manually key in the

format.

=

Barcode No. 2

Barcode name tast e
Barcode Type 1. EAN13

Barcode formNo salect s |
Barcode format
User Defined Barcode

DDINIPPPPPC
DDINIPPPPPPC

DiNPPPPPPC
DilnPPPPPC

4) After completing the fields, click “Save” button.

= Barcode

Barcode No. 2

Barcode name barcode3 S
Barcode Type 1. EAN13

Barcode format No DDINIPPPPPC

Barcode format DDINIPPPPPC
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3.2.7. Data — Tare

- This menu is for generating, modifying and deleting Tare data.

b 4 CL8000 PROGRAM MODE

PLU

- o
Sales Message

Origin

Barcode

Quantity Unit Symbol

2804211223

3.27.1. Create New Tare
1) Click “New” button.

= | Tare

Tare No Tare name Tare Type

Tare value

73



CL800O0 Label Printing Scale

2) Type in Tare No. and Tare Name

T B

Tare Na. 1

Tare name tarel

Tare Type 1. Numeric Tare

Tare value 034

PROGRAM MODE > Data > Tare dealer 09-09-21 10:19

3) Choose a Tare Type

Tare name =

PROGRAM MODE > Data > Tare

1. Numeric Tare
2. Weight Tare
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4) Depending on the Tare Type, the Tare value can be entered directly or through weight
measurement.
-Numeric Tare: you can directly enter the Tare value.

The Tare value must be entered according to the unit of weight measurement.

( Ex:in the case of 6/15kg e=d=2/5g, lessthan 6kg:0.02kg / over 6kg : 0.05kg)

If an incorrect value is entered, the following warning window is displayed

Wrong value input

-Weight Tare : Enter the actual weight measured value.

= | Tare

[ sne |
Tare No. 2
Tare name tare2 8
Tare Type 2. Weight Tare
Tare value 0,080

75



CL800O0 Label Printing Scale

3.2.8. Data — Quantity Unit Symbol
- This menu is for generating, modifying and deleting Quantity Unit Symbol data.

(You can specify each PLU’s counting units for products)

b 4 CL8000 PROGRAM MODE
- PLU

Group

ST

Origin

Barcode

¥¢ Quantity Unit Symbol
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3.3. DATA MAINTENANCE MENU

- Please refer to the following steps to access Data Maintenance menu.

X CL8000 PROGRAM MODE
Select PLU Items
Delete data

Label Form

 Data
Maintenance

3.3.1. Data Maintenance — Select PLU ltems

- You can choose to display or hide PLU fields in Data - PLU menu.

b 4 CL8000 PROGRAM MODE

©r Select PLU ltems

Delete data
Data
[ ¥
' Maintenance
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1) Items that are checked “Yes” will be displayed on the PLU; items with “No” will be

hidden. Once the selection is complete, press “Save” button.

Plu Name UseYN
Department No. ®) Yes No B
PLU No. @ Yes No
PLU Type @) Yes No
Name @) Yes No
Name2 ®) Yes No
Name3 @) Yos No
Named Yes (@ No
Name5 Yes (@ No
Name6 Yes (@) No
Name7 Yes (@) No

2) Enter “PLU” submenu under “Data” menu to make sure that the settings have been

applied.

X CL8000 PROGRAM MODE

7w PLU

Department
Sales Message
Origin

Barcode

Quantity Unit Symbol
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3) Select the PLU.

—J PLU
“ 1. default : ALL *
PLU Type Name - Unit Price

1 COUNT Apple 155 =
2 WEIGHT Banana 5.5
3 WEIGHT Avocado 5.99
4 WEIGHT Cherrie 5
5 WEIGHT Watermelon 5
6 WEIGHT Brocoli 8.99
7 WEIGHT Carrots 20
8 WEIGHT Cilantro 21.25
9 WEIGHT Potatoes 10
10 WEIGHT Pepper 2

4) Check the PLU fields.

T e
Depastment

Ho. default

PLUType @) WEIGHT COUNT

Unit Price 100
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3.3.2. Data Maintenance — Import PLU data

- Import PLU data from external device

33.21. FIP

X CL8000 PROGRAM MODE
elect PLU ltems
LU data >

Select Nutrifact ltems

» Data
" Maintenance

PROGRAM MODE > Data Maintenance > import PLU data > FTP Gues: 0421 1428

1) Enter the FTP server connection information (FTP Config)

w PLU Field Matching  FTP Scheduler Config
]
Al
Ip Address 172.16.18.48
Port 21
User ID userl
Password  esseesse
FTP File Path i
FTP File Name: PLU k. txt
FTP Backup File Location /backup
FTP BackupiDelete None
File Comment i

200421 1433
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# IP Address
# Port

# User ID — FTP server user ID

# Password — FTP server password

# FTP File Path — FTP Server file Path

# FTP File Name — FTP Server file name, extension

# FTP Backup File Location — FTP server backup path

# FTP Backup Delete — Whether to back up and delete files in FTP Server

# File Comment — Skip Sign. (Lines beginning with this letter are ignored)

# File Separator — Separates each item in the file

# File Start Line — The line number in the file to start reading (If it starts with 0 or 1, read

from the first line)

2) Click ‘Connect Test’ button to check the possibility of connection

FTP

‘ 172.16.18.48

Alarm

FTP server connect success
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3 Move to the ‘PLU Field Matching’” menu

FTP Config FTP Scheduler Config
[ s | aw | co | repece Joomedrse] imorree |

PLU Field Matching

PROGRAM MODE > Data Maintenance > import PLU data > FTP. uest 2804211434

4) Click ‘Download File’ button to download file from FTP server.

Check the first line (start line) data after success to download

FTP

PLU Field Matching

PROGRAM MODE > Data or ata > . 280421 1434
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1. PLU No.

Alarm AME 2 BURNER SH

FTP server files download

Close

5-1) Assign each item in the file to each item in the PLU

Click ‘Add’ button to add additional information

= | FTP

FTP Config [zNER=T=I] Matchlng FTP Scheduler Config

1

1sL2AME 2 BURNER SH

0

188000
PLU Field Matching

PROGRAM MODE > Data nport PLU data > FTP ealer 28-04-2115:17
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5-2) Select ‘None’ for unused items

Each item can set once. (‘None’ can set multiple times)

None Department No
PLU No. PLU Type a8
Unit Price MName
Mame2 Name3 N
1300g
Named Names | 1
Mame6 Name?
Mameé Special Price N
Pieces Tare | -
Tare No % Tare
Tare % Limit Label No.1
Label Na.2 Barcode No.1
Barcode No.2 Quantity Unit Symbal No,
[ clos |

5-3) ‘=’ button can change the location

FTP Config [EMSRZERRETSTGE FTP Scheduler Config

S
1. PLU No. = 1
2. Name = | 1sL2AME 2 BURNER SH
3. PLU Type = |o
4. Unit Price = | 188000

PLU Field Matching

AM MODE > Data Maintenance > Import PLU data > FTP
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5-4) Click the ‘Edit end’ button to delete the fields using delete icon.

Click the ‘Save’ button to save the information.

= | FIP
FTP Config WEREA=EERNEEINAE FTP Scheduler Config
0

1. PLU No. W1

2. Name W | 1sL2AME 2 BURNER SH
3. PLU Type m|o

4. Unit Price o | 188000

PLU Field Matching

6-1) Use ‘Replace’ function to convert the value of items

Click the ‘Replace’ button.

FTP

FTP Config RVASEGIYETEINGE FTP Scheduler Config

B
1. PLU No. m 1
2. Name @  1sL2AME 2 BURNER SH
3. PLU Type m o
4, Unit Price @ 188000

PLU Field Matching

PROGRAM MODE > Data Maintenance > Import PLU data > FTP dealer 280421 15:11
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6-2) Click the ‘New’ button.

PLU Field Original Text Replace Text

Close

6-3) Enter the value, click the ‘Save’ button

| PLU Replace

PLU Field PLU Type

Original Text 2

Replace Text 1
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# PLU Field — Select PLU item

# Original Text — The Original value of the item in file

# Replace Text — The Value to change

# Ex) In case of PLU Type, Original Text :2, Replace Text :1

=> [f the value of PLU type in the file is 2, it is changed to 1

6-4) Delete or modify the Replace settings

(= u =]
PLU Field Replace

| PLU Replace

PLU Field PLU Type

Original Text 2
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7) Click the Import File button to import the file data into the scale according to the

matching settings.

= | FTP

FTP Config RZNIRSELEREVTGE FTP Scheduler Config
e £

1. PLU No. = 1

2. Name = 1sL2AME 2 BURNER SH
3. PLU Type = o]

4. Unit Price = 188000

PLU Field Matching

1. PLU No.

E 2 BURNER SH

FTP server files were downloaded
successfully.

Close
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8) Set the automatic import schedule in the ‘FTP Scheduler Config’ menu.

= | FTP
FTP Config  PLU Field Matching _ Scheduler Config

Use Scheduler @) Yes No
Start Date 2021-04-01
End Date 2021-04-30
Start Time 08:00
End Time 18:00
Day 0
Hour 1
Minute 0

PROGRAM MODE > Dath MaIMenance > Inport PLU 041a > FTP.

# Use Scheduler— Whether to automatically proceed with the import operation

# Start Date / End Date

# Start Time / End Time

# Day / Hour / Minute — Schedule Interval

# If ‘Use Scheduler’ is set to YES, the operation of downloading the file from the FTP
server and saving the PLU data to the scale is repeated at every set time interval within

the set time and date.
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3.3.3. Data Maintenance — Delete data
- This page is for deleting saved data by category.

X CL8000 PROGRAM MODE

Select PLU Items

Import PLU data »
77 Delete data

g Data e :
= Maintenance Label Form

utrifact Items

Delete File

1) This menu can only be accessed by users with user authority level 3 (admin) or

higher. Click the login button to log in.

— BOOKMARK
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2) Click “Delete All” button located in the same row as the item which needs to be

deleted entirely.

Delete data
Delete All

Delete Al

Delete Al

Delate Al

e
-
-
—
e

Tax

3) Once the confirmation window pops up, click “OK” to delete all data of the item.

User will be alerted if there is a PLU which uses the selected data.

Deleting data in use will remove the data from the used PLUs as well.

Alarm

Delete All Data?
Currently, there are 1 Group
Relation 0 Product.
(You can 't recover deleted data)
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4) Check the deleted data.

#You can also see in the field(s) which also used the deleted data that the data are

deleted.
]
Label No.2 elect
8]
Barcode No.1 sedect
Barcode No.2 select
Tare 0
Group No. test
Sales
‘Specio Group No. select $
Unit Weight 0
Nutritact. A d

#Caution: In case at least one data needs to remain in a given item, performing Delete

All will not delete Data No. 1 (e.g.: Department).
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3.3.4. Data Maintenance — Label Form

- In this menu, you can delete the label form.

x CL8000 PROGRAM MODE

Select PLU ltems
Import PLU data
Delete data
Data
~
ﬁ i
Select Nutrifact Items

Delete File

PROGRAM MODE > Data Maintenance > Label Form

1) This menu can only be accessed by users with user authority level 3 (admin) or

higher. Click the login button to log in.
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2) ‘Default Form’ is a label form already saved in the scale and cannot be deleted.

=  Label Form
Default Form 5 [TTF]Label 05(Nutrition)

User Design Form 10 [TTF]Label_10(60x40)

11 [TTFJRU 11 (58X40)

Label

3) ‘User Design Form’ is a label form saved by the user in the scale, and can be deleted

by clicking the ‘Delete’ button after checking the check box.

Label Form

Default Form 90 Label-90

User Design Form

ik

ROGRAM MODE > Data Maintenance > Label Form
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Default Form Label-90

¥ 9%

User Design Form

Alarm

Are you sure you want to delete the label
form?

II Close

!

3.35. Data Maintenance — Select Nutrifact [tems

- In this menu, you can set the items to be used among Nutrifact items.

PROGRAM MODE > Data Mairten

x CL8000 PROGRAM MODE
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1) After setting the Nutrifact items to be used as Yes, you can save them by clicking the

Save button.

Nutritact Field Name Activation
Base Size @) Yes No =
Calcium @) Yes No
Calories @) Yes No
CaloriesFat @ Yes No
Carbohydrate @) Yes No
Cholesterol @ Yes No
Description @) Yes No
DietaryFibers ®) ves No
- @ Yes No
PROGRAM MODE > Daia Main

2) When set to No, it is not displayed in the Nutrifact item of PLU.

[ sae
Nutrifact Field Name Activation

Base Size Yes (@) Nao &
Calcium Yes (@) No
Calories. ®) Yes No
CaloriesFat @) Yes No
Carbohydrate ®) Yes No
Cholesterol @) Yes No
Description ®) Yes Na
DietaryFibers @) Yes No
etc ® Yes No

PROGRAM MODE > Data Main Salect m Gues munTw
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= | PLU
Nutrition facts A
Calaries CaloriesFat
Cartohydrate Cholesterol
Deseription DietaryFibers
etc Iron
Protein Saturated Fat
Serving Per Serving Size
Serving Size Text Sodium
Sugars Total Fat
Type Unit
PROGRAM MODE > Data > PLU

3.3.6. Data Maintenance — Delete File

- In this menu, you can delete image files related to PLU, Advertisement and Category.
1) After selecting One of the PLU, Advertisement or Category, check the file to be
deleted and click the Delete button to delete it.

= | Delete File

I Delete I | Select Al
Product File «  avocado.jpg

Category File #  lobsterjpg

Mavie File #  pearjpg

¥  mangosteen.jpg
File
#  broccoli2.jpg
«#  bananas.jpg

# comjpg

«  carrots.jpg

[ L e —————————" — 20421 1537
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3.4. STORE MENU

b 4 CL8000 PROGRAM MODE

Store Information

User & Security

Advertisement

Category

PROGRAM MODE > BOOKMARK

3.4.1. Store — Store Info

- This menu is for generating, deleting, and modifying store info.

X CL8000 PROGRAM MODE

vy Store Info

User & Security »
Advertisement »

Category

PROGRAM MODE > Store > Store Info Guest

2020-08-06 12:00
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3.4.1.1.  Register New Store Info

1) Click “New” button.

= Store Info

Store Id

Store name

2) Key in Store Info ID, Name, Telephone and Text, then press “Save” button.

Store ID

Store name

= Store Information

Mart

010-1111-2222

9
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34.1.2.  Modify Store Info

1) Click a Store Info to begin modification.

— Store Information

Store ID Store name Telephone Store text
1 CAS 010-1234-5678 Scale Mart
| 2 Mart 010-1111-2222 mart l

2) Modify Store Info, then press “Save” button.

Store ID

Store name. Mart g
Telephone 010-1111-2222

Store text mart

0200814 16:05
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3.4.1.3.

Delete Store Info

1) Select the Store Info which needs to be deleted.

— Store Information

Telephone Store text

1 CAS 010-1234-5678 Scale Mart

| 2 Mart 010-1111-2222 mart I

2) Click “Delete” button to bring a pop-up window to confirm deletion.

= Store Information

Save I Delete I

Store ID

Store name Mart 8
Telephone 010-1111-2222

Store text mart

PROGRAM MODE » Stor vation Guest 2020.69.14 16:06
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3) Click “OK” button to delete the selected Store Info.

Are you sure you want to delete this Store &=
Information?

34.2. Store — User & Security

3421, User

- This menu is for generating, deleting, and modifying User info.

b 4 CL8000 PROGRAM MODE
Menis Permission

Advertisement »

Category

PROGRAM MODE >
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1) This menu can only be accessed by users with user authority level 3 (admin) or higher.

Click the login button to log in.

= BOOKMARK

34211. UserLevel

1) There are three user levels.
Each user level is given its own Readable / Modifiable levels
Readable / Modifiable levels attributed to each user level can be configured in 3.4.2.2

Menu Permission.

User type Level
Guest 0
User

Chief user 2
Admin 3

User will be given permission levels that fits the account when logging into PROGRAM
MODE.

Not logging in with any account will auto-assign the user with Guest permission levels.
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34212. Create New User

1) Click “New” button.

- A new user account can be created only with the admin account.

User ID User nickname User level

admin admin E

PROGRAM MGDE > Sore » User > Us ™ 20206914 16:10

2) Type in User ID, Nickname, Password, Level, then press “Save” button.

= User
Save
User ID user0l
User nickname user0l
User password e

User level 1. Clerk
1. Clerk
2. Chief Clerk
3. Admin

7

104



CL8000 Label Printing Scale TOTALWEIGHING SOLUTION™

34.21.3.  Modify User

1) Choose a user which needs to be modified.

- User can be modified only with the admin account.

= User

User ID User nickname User level

admin admin 3 =
I user01 user0l 1 I

0200924 18:22

PROGRAM MODE > Store > Ut

2) Modify user info, then press “Save” button.

= User
| Save I Delete
User ID user0l
User nickname user0l
User password
User level 1. Clerk

20200014 18:23

L r————
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34.214. Delete User

1) Choose a user which needs to be deleted.

- User can be deleted only with the admin account.

= User
User ID User nickname User level
admin admin 3 =
I user01 userol 1 I

20200014 18:22

2) Click “Delete” button to bring a pop-up window to confirm deletion.

= User
save I Delete I
User ID userd1
User nickname: usero1 =
User password
User level 1 Clerk

PROGRAM MODE >
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3) Click “OK” button to delete the selected user.

3.4.22. MenuPermission

- This menu is for setting permission level for reading or modifying each menu of the

scale.

# This menu is readable only with the admin account.

x CL8000 PROGRAM MODE

mation User

A ement Function Permission

Category Security Config

PROGRAM MODE > Store > User & Security > Menu Permission 09-09-21 13:50
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1) Set permission level with each submenu, then press “Save”.
Modifiable (write permission) - Permission for the current user to modify the selected menu

Readable (read permission) - Permission for the current user to access the selected menu

Menu Name:
BOOKMARK. 1. Guest B 1. Guest B (&
Data_PLU 1. Guest B 1. Guest B
Data_Department 1. Guaest . 1. Guest .
Data_Group 3. Admin ' 3. Admin ] I
Data_Tax 1. Guest . 1. Guest B
Data_Salos Massaga 1. Guest B 1. Guest B
Data_Origin 1. Guest B 1. Guest B
Data_Borcode 1. Guest . 1. Guest
Data_Tare 1. Guest . 1. Guest
Data_Quantity Unit Symbol 1. Guest s 1. Guest s

2) Readable level cannot be set higher than Modifiable level.

(Modifiable level >= Readable level).

— Menu Permission

Save

BOOKMARK ‘ 0. Guest s 0. Guest 3 1o
Data_PLU | | 0.Guest o | ‘ 0. Guest .
alert
Data_Department uest .

| Readable grade cannot be higher than

e Sate modifiable grade.

Data_Tax Suest .

Dt Solsessage suest .

——— s =

Data_Barcode ‘ 0. Guest B 0. Guest .
Data_Tare ‘ 0. Guest ® 0. Guest L

Data_Quantity Unit Symbol ‘ 0. Guest N | 0. Guest .
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3) Configuring Readable / Modifiable levels of each menu will prohibit users which do
not meet the Readable / Modifiable levels from reading or modifying the given menu.
For example, if the account that a user used to log in has User levels:

If Readable level of “Group” menu is set to “User”, Group menu will be visible to the
user.

However, If Readable level of “Group” menu is set to “Admin”, Group menu will not be

visible to the user.

b4 CL8000 PROGRAM MODE

PLU

Group

SalesMe 3¢ | CLB000 PROGRAM MODE
i PLU
Barcode

Sales Message
gy s

Barcode

Quantity Unit Symbol

PROGRAM MODE )

If Modifiable level of “Group” menu is set to “User”, user will be able to modify the
“Group” menu.
However, if Modifiable level of “Group” menu is set to “Admin”, user will be not able

to modify the

“Group” menu.
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B B

Group No.

e I ©

3.4.2.3. Function Permission
- In this menu, you can set up the permission to use Function key.

# This menu is readable only with the admin account.

b4 CL8000 PROGRAM MODE

User

User & Security » Menu Permission

ity Config

PROGRAM MODE > Store > User & Security > Function Permission 09-09-21 14:12

110



CL8000 Label Printing Scale TOTALWEIGHING SOLUTION™

1) Set permission level with each Function Key

(ex, Override — use more than Admin authorization)

UNIT3 0. Guest
FEED 0. Guest & S
PREPACK 0. Guest
NET WEIGHT 0. Guest
20< 0. Guest
TARE 0. Guest
NUMBER 0. Guest
OVERRIDE 3. Admin
FOR 0. Guest
x 0. Guest
AUTO 0. Guest

PROGRAM MODE > Store > User & Security > Function Permission 09-09-21 13:51

2) On sale screen, Press the function key with permission (Ex: Override)

5 Fruit
2 3 B
N 0e)
Apple Banana Avocado
n R 18
! &s A
Melon Pineapple Lemon

Strawberry Kiwi Pomegranate Blacberry Raspberry

LY

Grapefruit Coconut Grapes Orange Mango

®
] PNy '
o|lo|ln|nE

Ojlo|lo|lw
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kg WEIGHT kg N ICE $kg ~TOTAL PRICE $

0000 0000 1550  0.00

@e dhel Gl

Login

>0<  TARE oisciw)

SAVE STITL

OVER

RIDE PLY

X

Max. 6/15kg Min. 40g e=d=2i5g (i

-When you dlick the function key with permission, the login window appears
As the permission level is Admin, In oder to use function key you have to login at least Admin (3

level) authority.

3.4.24. Security Config
- This menu sets security-related details.

# This menu is readable only with the admin account.

X CL8000 PROGRAM MODE

Store Information

User & Security 3

rlisement 3

PROGRAM MODE > Store > User & Security > Security Config 09-09-21 13:51
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1) set the each item

Security Config

Save

Function Key User Check No

PROGRAM MODE > Store > User & Security > Security Config admin 09-09-21 13:51

# Function Key User Check-> when using the function key, whether to check the

authority

3.4.3. Store — Advertisement

3.4.3.1. Slide Show

- This submenu is for configuring auto-play of slide show when scale is not being used.

x

CL8000 PROGRAM MODE

17 Advertising video
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1) Click “New” button.

Slide Show

1 ‘GASTRO-Sound-ON.webm ] 1S

2) Set up a slide show for videos or images.
# Use Advertisement - You can choose whether to use it or not.
(Only one slideshow can be set to Yes., If you select Yes and save, other slideshows will

change to No.)

=  Slide Show
| Use Advertisement Yes No
' (=] S
Select *
[+
Hour
Minute
Second
Date Setting Yes No
Sunday Monday Tuesday Wednesday Thursday
Day Of Week
Friday Saturday
Stan Date
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=  Slide Show

Use Advertsement

# File — You can add images or video files to be used in the slide show.

(+:add,

- : delete)

=  Slide Show

Use Advertisement Yes No

Hour
Minute
Second
Date Setiing Yes No
Sunday | Monday = Tuesday = Wednesday  Thursday
Dy OLTeS Friday Saturday
Start Date

050121 1047
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# Hour, Minute, Second - When an image is added, set how long the image will be

(Video is not affected.)

=  Slide Show

displayed.

Use Advertisement

File

Yes No

Select - : S

Yes No

Sunday  Monday | Tuesday  Wednesday  Thursday

Friday = Saturday

# Date Setting - You can set the date and time the slide show will run.
(If ‘Use Advertisement’ is set to No, it always works.)

# Day of Week — Specify the day of the week

(If Date Setting is Yes, one must be checked)

# Start Date / End Date

# Start Time / End Time

=  slide Show

0]

Date Sefing Yes (| No

Sunday  Monday | Tuesday = Wednesday = Thursday

Friday ~ Safurday
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# Date / time

2020

BELIERA

20

27

January 2020

Mon Tue Wed Thu

Cancel

25

0Ok

07

08

09

Cancel

27
28
29
30

31

32

33

Ok

3) Moving to the home screen and not using the scale for a set amount of time will

begin the auto-play.
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4) Touching the screen or changing the loaded weight will stop the commercials and

resume the sales mode.

0.000 0.000 U.00 .00
3 Fruit
- - 00 =
1 2 3 4 A 5
Apple Banana Avocado Cherrie Watermelon
n R I 4 o [ Y
O Q|4 g JE
Melon Pineapple Lemon Peach Green apple
16 17 i 18 !I 19 I 20 ' " —
Strawberry Kiwi Pomoaunl(; Blacberry Raspberry 1 2 3
PR Y e ) o00-
Gmn_e;; Coconut Grapes Orange Mango 7 8 9
- DEE
3.4.3.2. Advertising Setting

X

CL8000 PROGRAM MODE

Store Information Slide Show

Advertisement » | % Advertising Setting

Category
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1) Wait Time(Sec) : Ads are shown at times when the scale is not in use.

If the scale has not been used for the time set in Wait Time, an advertisement is

displayed.

[ = 1

= Advertising Setting

| Wait Time(Sec)

L r——

Advertising Setting

050121 1048

3.4.4. Store — Category

- This menu is for generating, modifying and deleting Category info.

1) Click in the following order: Store -> Category.

PROGRAM MODE )

x CL8000 PROGRAM MODE

Store Info
User & Security

Advertisement

>

>
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3.4.4.1. Create New Category
1) Click “New” button.

Default ¢ n

Catagory No. Categary name Active

2) Type in Department, Category No., Name, Image and Active, then press “Save”

button.
— Category
Department Id. Default
Category No. 1
Category name
o
Active YES
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3) Click “Load Image” button to assign a category image.

= Category
X [——

| DRl 1

avocado jpg Iobster.jpg imodink_10jpg  mangosteen.jpg
.
persimmons.jpg carrots jog bell-pepper.ipg fruit.png

|4

grapes.jpg grapes2.jpg watermelon.jpg cherries2.jpg

3.4.4.2. Modify Category

1) Click a category to begin modification.

Category No. Category name Active

1 categoryl ¥ =
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2) Modify info in the category fields, then press “Save” button.

— Category

Department Id.

o

Default

catagoryl

Load Image m

YES

3.4.4.3.

Delete Category

1) Select the Category which needs to be deleted.

Category No

Category name Activation
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2) Click “Delete” button to bring a pop-up window to confirm deletion.

‘ Department 1. default
Category No. g
Category name Vegetable
Display Image Load Image
|
Activation Yes

PROGRAM MODE > Store > Category

3) Click “OK” to delete the selected category.

Delete this Data?
Currently, there are 1 Category
Relation 3 Product.

(You N ver deleted data)
e |

# Category 1 cannot be deleted.
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CategorylD 1 cannot be deleted

Close | =

3.5. REPORT

X CL8000 PROGRAM MODE

Realtime Report

> Stamsart » Raport Type
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3.5.1. Report — Standard

35.1.1.  Period

- This menu is for viewing the sales report by period

X CL8000 PROGRAM MODE

» Report Type

1) Check the sales information by year, month, day, week, day of the week, and hour.

Year « Sales « Count « Weight +
2021 3173060 271808 2729804
total: 3173060 271808 2729804

B T p—

[Year-Report]
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2021—0148 2021-02-15 || 1. Defauhtas || ALL =

Month « Sales Count Weight «
2021-01 3173060 271808 2729804
total 3173060 271808 2729804

[Month-Report]

d

2021-01-18 | | 2021-02-15 1.Defaultas ¢ || ALL  #
Day Sales « Count =
2021-01-20 33530 152
2021-01-21 1460 146 1460
2021-01-22 1460 146 1460
2021-01-23 1460 146 1460
2021-01-24 1460 146 1460
2021-01-25 1460 146 1460
2021-01-26 1460 146 1460
2021-01-27 1460 146 1460
2021-01-28 101460 10146 101460
2021-01-29 2601460 260146 2601460
total 3173060 271808 2729804

[Day-Report]

126




CL8000 Label Printing Scale

TOTALWEIGHING SOLUTION™

2021-01-18

Weekly +
4
5

total

2021-01-18

2021-02-15 1. Defaultas ALL z

Sales »

464300

2708760

3173060

2021-02-15

1460

197190

232120

34990

102920

2602920

1460

3173080

[Week-Report]

Count +
932
270876

271808

314

298

10292

260292

146

271808

21044

2708760

2729804

1460

8740

8500

3804

102920

2602920

1460

2729804
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d

2021-01-18 2021-02-15

03

04

05

06

07

08

09

1. Defaultas ¢

Sales «
192910

28020

14640

23600

23520

2614520

138040

23520

39330

11840

3173060

ALL

[Hour-Report]

2

2

261452

314

2

4

f

271808

102834

588

588

590

588

2614520

6226

588

n7s

296

2729804

2) Select a date to see sales information for the date.

2021

total

Sales

3173060

3173060

Count

271808

271808

Weigh
2729804

2729804
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CL8000 Label Printing Scale

3) Check the sales records by department.
3 I 1. Defaultas = ALL ®

2021-01-18 | | 2021-02-15
Count « Weight -

1. default

Year

2729804

2021 3173060 271808
3173060 271808 2729804

total:
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4) Use the product name or product number to check the sales record.

Year ¢ | 2021-01-18

2021

total:

PROGRAM MODE >

2021-02-15

1. Defaultas #

3173060 271808

3173060 27808

(o]

Weight

2729804

2729804

5) If click the graph icon, you can check the corresponding information as a graph.

Hour # || 2021-01-18 2021-02-15 1. Defaultas # || ALL *
- Sales
03 192910 102834
04 28020 5 588
0s 14640 2 588
06 23600 2 590
07 23520 2 588
o8 2614520 261452 2614520
09 138040 314 6226
10 23520 2 588
n 39330 4 n7ie
12 11840 1 296
total 3173060 27808 2729804
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week ¥ || 2021-01-18 2021-02-15 Department # || ALL

35.1.2.  ReportType

- This menu is for viewing the sales report by PLU or department

X CL8000 PROGRAM MODE

Standard > Period
[ ¢ Report Type

PROGRAM MODE > Rep
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1) View sales records for day, a week , a month by PLU or category.

- Check the sales record by selecting the product name or division.

Product Name # Department Select #
Today One Week One Month
Department +  Product id »  Product Name «
County Sales» Counte Saless County Saless
1 1 apple 0 0 260008 2619500 260008 2619500
1 2 banana 0 0 10041 536080 10041 536080
1 16 citrus 0 0 1 2880 1 2880
1 6 coconut 0 0 2 4500 2 4500|
1 5 grape 0 0 1 3970 1 3970
1 12 lemon 0 0 1 2240 1 2240
1 4 melon 0 0 1 3140 1 3140
1 10 pepper [ 0 0 730001 TSUWT(!I 730001 7301770
1 3 persimmans 0 0 1 3620 1 3620
Total 0 0 1000057 10477700 1000057 10477700

2) Search by product (department) name or product (department) number.

= R

ort Type

Product Name # | 1. Defaultasd s
Today 1 One Month
Productid +  Product Name «
Count ~ Sales » Count + Sales «

1 1 apple 0 0 260008 2619500 260008 2619500
1 2 banana 0 0 10041 536080 10041 536080
1 16 . citrus 0 0. 1 2880 1 2880
1 6 coconut 0 0 2 4500 2 4500
1 5 grape 0 0 1 3970 1 3970
1 12 lemon 0 0 1 2240 1 2240
1 14 melon 0 0 1 3140 1 3140
1 10 | pepper 0 U. 730001 7301770 730001 7301770
1 3 persimmaons 0 0 1 3620 1 3620

Total 0 0 1000057 10477700 1000057 10477700
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3) When you select a product, you can view detailed information.

— ype
Product Name i DPP;‘II"mEn' Select ALL i
Today One Week ‘One Month
Department »  Product id » Product Name »
Count» Sales+ Counts Sales » Count » Sales »

1 1 apple 0 0 260008 2619500 260008 2619500
1 2 banana 0 0 10041 536080 10041, 536080
1 16 citrus 0 0 1 2880| 1 2880
1 6 caconut 0 o 2| 4500| 2| 4500
i 5 grape 0 0 1 3970 1 3970
1 12 lemon 0 0 1 2240 1 2240
1 14 melon 0 0 T. 3140. 1. 3140
1 10 pepper 0 0 730001 7301770/ 730001 7301770
1 3 persimmans. 0 0 1 3620 1 3620
Total: 0 0 10000 57. 10477700. 10000 57. 10477700

tamdard > Department

202

2021-01-21

2021-01-22

2021-01-23

2021-01-24

2021-01-25

2021-01-26

2021-01-27

2021-01-28

2021-01-29

total

Day & | 2021-01-01 2021-02-15

1. Defaultas #

Sales
33530

1460

1460

1460

1460

1460

1460

1460

101460

2601460

3220040

CODE

Count
152

146

146

146

146

146

146

146

10146

260146

274291

Weight
2344

1460

1460

1460

1460

1460

1460

1460

101460

2601460

2755178
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3.5.2. Report — Management

3.5.2.1. Delete Transactions
- This menu is for deleting report data

b 4 CL8000 PROGRAM MODE

Standard [l ¢ Delete Transactions
Management » Other Report Settings

Realtime Report

PROGRAM MODE > Report >

1) Delete sales records by period or all.

= Delete Transactions

Delete Date Report Delete All
Delete All Delete All
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3.5.2.2. Other Report Settings

- View the sales report by PLU or department

X CL8000 PROGRAM MODE

Standard » Delete Transactions

Management » | 1% Other Report Settings

Realtime Report

= | Other Report Settings

Delete Schecluler(Day) EZ ]

# Delete Scheduler (Day)

: When the scale is turned on, data that have passed the period set in this item are
automatically deleted.

For example, if you enter 365, sales data older than 365 days will be deleted.
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3.5.3. Report — Realtime Report
- This menu is for view the various types of sales reports.

b4 CL8000 PROGRAM MODE

Standard »

Management »

77 Realtime Report

‘

PROGRAM MOGE > Report > Realtima Raport

1) View the various type of report.

# Various periods : year, month, day, week, day of the week, hour
# Set a specific period

# Search by Department

# Search by PLU Name, PLU Number

= Realtime Report

L T T ——

[day-graph]
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— Realtime Report

week * || 2021-01-18 2021-02-15 1.Defaultas + | ALL = n E

PROGRAM MODE > Repurt > Realime Repost

[day of the week-graph]

= | Realtime Report

L a e —— e 2021-02-15 1736

[hourly-graph]
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3.6. SETUP MENU

3.6.1. Setup — Global setting

3.6.1.1. LabelID

- This menu is for configuring Global Setting - Label

b4 CL8000 PROGRAM MODE

‘ Global setting » | ¥ Label ID

Print » Barcode

Config » Sale Made

Keypad » Scals Config

Date Time

1) You can choose to use or unuse Global Label, and the label form which you would use.

= | Label ID

Use Global Label Form Ho
E
First Label [TTF]Label_10(60x40).10 +

# First Label - The first label form which is used at the event of sales.
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3.6.1.2. Barcode

- This menu is for configuring Global Setting - Barcode

x CL8000 PROGRAM MODE

Global setting » Label ID

Config Sale Mode
Keypad Scale Config

Date Time

1) Check “YES” in the “Use Global Barcode” row, select each barcode item then press

“Save” button.

= | Barcode

Save
Use Global Barcode Form ®) Yes No
Weight PLU Barcode 1. barcodet : g
Count PLU Barcode 1. barcode1
Misc. Weight Barcode 1. barcodel
Misc. Count Barcode 1. barcodel
Misc. PCS Barcode 1. barcodet
Add up TTL Barcode 1. barcode1
Add up TTL Barcode2 1. barcodel
Barcode 2 1. barcodel

PROGRAM MODE > Setup > Global Setting > Barcode Guest 09-09-21 15:44

# Weight PLU Barcode — Weighed product
# Count PLU Barcode — Counted product

# PCS PLU Barcode — PCS product
# MISC Weight Barcode — MISC Weighed product
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# MISC Count Barcode — MISC Counted product

# MISC Pcs Barcode — MISC PCS PCS product

# Add up TTL Barcode — Barcode 1 of Total Label
# Add up TTL Barcode2 — Barcode 2 of Total Label

# Barcode2 — For Barcode2

3.6.1.3.  Scale Config

- This menu is for configuring Sales Mode and templates of scale.

b 4 CL8000 PROGRAM MODE

Global Setting 2 Label ID

Print » Barcode

Detailed Configuration »  [EESEECTEIEY el Il

Keypad »

PROGRAM MODE > Setup > Global Setting > Scale Config Guest 09-09-21 15:44
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1) set each item

Scale ID 1
PCS Symbol EA =
Department Na. 1. default
Prefix
Store No. 1L.CAS
Use Transaction No
PROGRAM MODE > Setup > Global Setting > Scale Config Guest 09-09-21 15:44

# Scale ID -scale number

# PCS Symbol — The unit that follows the number of Count/PCS items sold (Global

Setting)

# Department No. — The department number used to call the product call.

# Prefix — The fixed value printed on the barcode.
# Store No. — Store infromatin,

# Use Transaction — Whether to use real-time report transmission.
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3.6.2. Setup — Print

3.6.2.1.  Print Label ltems

- This menu is for setting print options by field when printing labels.

4 CL8000 PROGRAM MODE

Global setting (W 77 Print Label tems

Config »

Keypad 3

Date Time

1) Once the setting is complete, press “Save” button.

= Print Label ltems

I Save I
phu Number o Yes No
plu Name' e v N 2l
phu Name2 o Yos No
plu Name3 o Yos No
plu Named. @) Yes No
phu Nameb o v N
piu NameB: o Yes No
plu Name? o Yes No
phu NamoB: o Yos No
Department Name @) Yes No
Department Numbsr ® Yes No
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3.6.2.2. Label Caption

- This menu is for configuring printing value when printing caption portion of label fields.

X CL8000 PROGRAM MODE

Global setting Print Label Items
I

Config »

Keypad »

Date Time

1) Type in values in the label caption fields of your choosing, then press “Save” button.

(Printing label caption fields will print the saved values)

= | Label Caption

Total Price

By-Weight Unit Price
By-Count Unit Price
By-PCS Unit Price
Weight

Quantity.

Tare

TOTALPRICE %C

PRICE %C/%U

PRICE %C

PRICE %C/pcs

WT %W

QUANTITY

TARE %W

SAVED PRICE

REG PRICE

TAX %C

PACKED ON
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3.6.3. Setup — Config

3.6.3.1. Sale

- This menu is for configuring sales-related settings.

x CL8000 PROGRAM MODE

Print 3

Keypad »

Date Time

1) Click “Save” button to save the sales configuration.

P

Start auto mode(start up) ® Yes No

Product Call Type @ PLUNO Short Key S

# Start Auto mode
: Set On / Off status of Auto mode when the application starts.

If Auto mode is on, a product will be auto-sold and label printed out once the indication

144



CL8000 Label Printing Scale TOTALWEIGHING SOLUTION™

stabilizes.

# Product Call Type

: Set values which will be used when looking up products.
PLU NO - Look up product that corresponds to the PLU No.

Short Key - Look up product that corresponds to the Short Key.

3.6.4. Setup — Keypad

3.6.4.1. Keypad Layout Type

- Keypad layout type are two types’ General type, full type

1) General Type

On sale screen. Both product key and function key are displayed.

On general type, you can use 2 function key pages.

D.000 ).000 U.00 U.00
g Fruit
2 3 4 A5 7 oo —
Apple ; Banana Avocado Cherrie Watermelon
n i} Y 13 ) 14 o 15 ‘
\ % o # r
I;G-;ﬂ Pineapple Lemon Peach Green apple 0
16 [ 17 18 19 I 20' . ——
iy dw P;m.!n.; ey | rviery W1]2]3
21 2 2 2 4 5 6 =
%t Q e ‘3
o7 71819
Grapefruit Coconut Grapes Orange Mango
o N
[Page 1]
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AR 5 i O s/ka o B
% Fruit
00Se e
1 2 3 ] 4 A 5 7 =
) 2 [ 1O
Apple Banana Avocado Cherrie Watermelon
n Re. 13 14 o v i4e
' ; : misc | misc
" " Fxo TYPE [EIGHT] COUNT
Melon Pineapple Lemon Peach Green apple misc kpeca} | o o | NET
pcs | PRICE WEIG
16 17 " 18 19 20 %
' LAST DATE
‘ * a voio | Voo fparTmel Zo
Strawberry Kiwi Pomegranate Blacherry Raspberry T_STOH SPEEDEDT ITEN SET'ELTB
2 23 24 25 pack | eoir | eor | EDIT
—= Lager | LABEL | DATE
2 mMsG | TIME
Grapefruit Coconut Grapes Orange Mango
Q
0g e=d ] 0
[Page 2]

2) Full Type : There is only products key on the sale screen, if you click the side tap, the

function key appears

If you call the product in the sale screen, the function key appear automatically.
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AR q i PR $/ka OTAL PR
) Fruit
2 3 4 s 7 11
% .(G ) !
"E pa—
Apple Banana Avocado 1 Cherrie Watermelon Melon Pineapple
13 14 o ’ 15 ‘ Tas 17 i 18 !I 19 I
Lemon Peach Green apple Strawberry Kiwi Pomegranate Blacberry
20 T 23 24 25 26 Y
Raspberry Grapefruit Coconut Grapes Orange Mango Plum
27 ! 28 29 ‘ 30
&y | & ~
Pear Lime Papaya Durian
Q
g 0g i 00.00.39
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kg “WEIGHT kg UNITPRICE skg 'TOTAL PRICE  $

0.000 0.000 0.00 0.00

Select a Product
SAVE

OVER
RIDE

Max. 615kg Min. 40g e=d=2i5g (D &/ 15-10-21 16:00

3.6.4.2. Keypad Arrangement
- This menu is for design the Keypad.
When ‘Keypad Arrangement Type’ in the ‘Keypad Config’ menu is set to MANUAL, the

status set in this menu is applied to the sales screen.(see #Keypad Config )

x CL8000 PROGRAM MODE

Global Setting [l Keypad Arangement

Print > Function keypad

De! figuration » Keypad Config

Keypad 3 Product Info

PROGRAM MODE > Setup > Keypad > Keypad Arrangement 09-09-21 15:45
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3.6.4.2.1. Change category

1) You can select category and set the keypad for that category.

Keypad Arrangement

Fruit

+ | 1page
Fruit

Vegetabie

- I e
o

3 TS 5 1
Al 7
T 0O :
‘Apple i T Avocado rrie Watermelon PAISCS

3.6.4.22. Addpage

1) You can add a keypad page by clicking the New page button.

Keypad Arrangement

Fruit

1
¥
'

2 3 ges= 5 1
. \ A
WE 5 0e) “
“Apple “Banana Avocado errie Watermelon POGSCE

148




CL8000 Label Printing Scale

TOTALWEIGHING SOLUTION™

3.6.4.23. Delete page

1) You can delete the page on the keypad by clicking the page Delete button.

(Page 1 cannot be deleted.)

oo

3.6.4.24. Change page

1) You can change it by selecting the page of the category.

H Keypad Arrangement

v | e |

PROGRAM MODE > Setuy = Key

Page Delete

Save
S
Edit Mode .
===
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3.6.4.25. Editkeypad

- Product or function keys can be assigned to each item on the keypad.
1) Set the keypad to Edit Mode.

= Keypad Arrangement

e S eodd @ :
errie Watermelon PagsCE

Apple Avoma

oo

PROGRAM MODE > Setup > Keypad > Keyy Geveioper 27-EKM-20 1629

2) You can click an empty item on the keypad to specify a product, or click an existing

keypad item to modify it.

= Keypad Arrangement

& eoodd @ |
b
“Banana errle Watermelon POOSCE

oo @)

2783420 16:31

B T P — p——
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3) Set product, image, font, etc. on the keypad.

E [ a | Wi
| Fruit
= PLU NO. Name
—
[ (sal on

B

L
1 Apple
y Nickname: fEhto et the
z Banana Koy Hickrmrm | S
(sale)Watermelon
Apple a Avocado (sale) )
e /
[ Font Size
4 Cherrie
Touch o sed 16 . oo set e
Procut 5 Frocuct
6 Brocoli p
| | —
7 Carrots.
Touch to selh H:I‘HDSNU
Product a CHANTD | —————d . PO
X a Potatoes. J
= =
10 Pepper
Touch a sed Eh o seru
Product m paBss Provuc
J

| =1 -

# Select a product.

# Nickname can be set to display on the keypad instead of the product name.

# You can set the font size and color.

# You can set the image of the product.

4) The registered keypad is displayed on the screen.

— Keypad Arrangement

o &oo

“Banana Avocado errie Wllermelon

e o e @)

PROGRAM MODE > Setup > Keypad > Keypat it e 27-6KM20 16:35
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3.6.4.26. Delete keypad item
B You can delete each item on the keypad.

1) Set the keypad to Delete mode.

Keypad Arrangement

Fruit * | 1Page s New Page Page Delete m
S
¥ & oodd @
Apple “Banana Avor.aao errie Watermelon POdsee

oot | et

PROGRAM MODE > Sefup > Keypad > Keypad Arrangemen

2) You can click on the keypad entry to delete it.

= Keypad Arrangement

o I OQM :

Apple “Banana Avocado PAgsCe

T

27-6KM-20 16:02

L T —p ——
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3) You can check the deleted keypad items.

— Keypad Arrangement

S
errie Walemelon

Appn Avocaﬂn

New Product New Function . Delete Mode

PROGRAM MODE > Setup > Keypad > Keypad Arrangoment

3.6.4.27. Addkeypad item
- Each item on the keypad can be added.

1) You can add keypad items by clicking the New Product button.

Keypad Arrangement

e @@

Apple Banana Avocado Charrie ‘Watermelon

v ovenon | o @)

tup > Keypad > Keypad Arrangement 15-10-21 16:02
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2) You can check the added keypad items.

Keypad Arrangement

1. Fruit 1 Page

¥ 2 3 — [« 3N 5 7
: )
&N @e) o | oo B
1o voduct o
Apple Banana Avocado Cherrie Watermelon
F ;
"
o
T I
PROGRAM MODE > Setup > Keypad > Keypad Arrangement Guest 15-10-21 16:02

3.6.4.2.8. Save keypad

- You can save the set keypad information.

1) You can save the changed keypad information by clicking the Save button.

Keypad Arrangement

‘ Fruit

R b e dd

1Page

Touch to set the
ict Product Save Complete
Touch to set the Touch to set thy Touch 1 set
Product Product Product Product
-3 S 1
Touch tosetthe || Touch to set the Touch to setthe || Touch to set th
Product Product Product Product

New Product New Function
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3 4 5
\ 7
Qe
B I
Banana errie Watermelon

Avocado

The edited keypad is displayed on the sales screen.

P\L = 0,000 0,000 0,00 0,00

[4) ol Q

v

3.6.4.3. Function Keypad

- This menu is for configuring the Function Keypad.

x CL8000 PROGRAM MODE

Global Setting v Keypad Arrangement

Print » | 17 Function keypad

Detailed Configuration ¥ Keypad Config

Keypad 3 Product Info

PROGRAM MODE > Setup > Keypad > Function keypad 09-09-21 15:45
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1) Set the function key type

=  Function keypad
General Type * 1Page = Edit Mode .
I General Type
Full Type
>0< TARE DISC(-) DISC(%)
AUTO SAVE ADD ST/TTL
for OVER PRE
RIDE PACK
PROGRAM MODE > Setup > Keypad > Function keypad Guest 09-09-21 16:02

2) Set the page
General Type: page option: 1-2 pages. / Full Type: page option :1 page

Function keypad

General Type +

>0< TARE DISC() DISC(%)

AUTO SAVE ADD STITTL

OVER PRE
RIDE PACK

FOR PLU

08-09-21 16:02

PROGRAM MODE > Setup > Keypad > Function keypad
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3) Press “new fnkey” to add the function key. Or you can modify existent key.

Designate each function key’s Nick Name, Font Size, Font Color, Background Color etc.

[ = L Fuwconkeyps % & |
(&

- When setting the color, you can set it by selecting a color or directly entering the

R - |

*D

DISCOUNT 1

DISCOUNTPER 2

SPECAIL PRICE

3

FIXD 5
TYPE 6
MISC WEIGHT 13
MISC COUNT 14
MISC PCS. 15
UNIT1 40

Key
Nickname

Font Size 26

Font Color

Background
Color

Cvee | o ]

RGB color code

Select color

SFFFFFF

x

=] 1

- You can set Font size(8~40)
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Key
Name + Code » Nickname
[ e | ooiao | S
DISCOUNT 1
DISCOUNTPER 2
SPECAIL PRICE 3 14
Font Color 15
FIXD 5
16
TYPE 6 Background 17
Color
MISC WEIGHT 13 18
MISC COUNT 14 1
20
MISC PCS 15 2
UNITY

PROGRAM MODE > Setup > K

ypad > Function keypad

4) You can delete each key by changing Edit mode to Delete mode.

=  Function keypad

General Type ¢ | 1Page ¢
S
>0< TARE DISC(-) DISC(%)
AUTO SAVE ADD STITTL
FOR OVER
RIDE
PROGRAM MODE > Setup > Keypad > Function keypad Guest 09-09-21 16:03
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5) Press ‘save’ to save the setting.

Function keypad
General Type = 1Page B
>0< TARE DISC(-) DISC(%)
AUTO SAVE ADD STITTL
OVER
FOR  piDE
PROGRAM MODE > Setup > Keypad > Function keypad Guest 09-09-21 16:20

3.6.44. Keypad Config

- This menu is for configuring the Keypad.

X CL8000 PROSSRAM MODE
Global Setting Keypad Arrangement

Print » Function keypad

Detailed Configuration » [EESEEREV LRI S
Keypad » Product Info

PROGRAM MODE > Setup > Keypad > Keypad Config 09-09-21 16:22

159



CL800O0 Label Printing Scale

1) set each item

Keypad Config
Keypad layout type ® General Type Full Type
keypad Image Use ®) Yes No &
PLU keypad size 8X6
Keypad Arrangement
Method AUTO
PROGRAM MODE > Setup > Keypad > Keypad Config Guest 08-09-21 16:22

# Keypad layout type — Keypad display type.

# Keypad Image Use — Whether to use the image of the product keypad.

# PLU keypad size — Set product tile size that is displayed on Self Keypad screen.
# Keypad Arrangement Method

: Can choose to auto-arrange products or manually assign their locations.

- AUTO: Auto-assigns PLUs (product info) to the keypad in sequence.

- MANUAL -> User manually assigns products to the keypad.

# Self Keypad Type: Set product tile size that is displayed on Self Keypad screen.
# Keypad Arrangement Type

: Can choose to auto-arrange products or manually assign their locations.

- AUTO: Auto-assigns PLUs (product info) to the keypad in sequence.

- MANUAL -> User manually assigns products to the keypad.
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3.6.45. Product Info

- this menu is for configuration each product information on sale screen

x CL8000

PROGRAM MODE
Global Setting

Print

PROGRAM MODE > Setup > Keypad > Product Info

Keypad Arrangement

Function keypad

Keypad Config

| ¥z Product Info

10-09-21 16:50

1) After selecting the category and number of product information to use, you can set

product information by drag and drop in product info.

1. Fruit

PROGRAM MODE > Setup > Keypad > Product Info

Product Name

Product ID

Product Info

Origin

Name2

Name3

Named

Produced Date

Packed Date Duration

Packed Timg Duration

10-09-21 16:50
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AR g g PR g (@ PR
Stk Apple
2 3 . 4 A 5 7% Product ID : 1
S O Wl
e Packed Tme Duration : 16:05
Apple Banana Avocado Cherrie Watermelon
11 % 13 14 o 15 1.‘
- -
Melon Pineapple Lemon Peach Green apple AUTO A DD
16 17 18 19 20 .
Strawberry Kiwi Pomegranate Blacberry Raspberry 1 2 3
21 23 24 25,
L @ | LS e
e 7/81]9
Grapefruit Coconut Grapes Orange Mango
00/ 0| C
40g e=d=2/5g B 00.00.39

3.6.5. Setup — Date Time

- This menu is for configuring the standard time zone.

X CL8000 PROGRAM MODE
Global sstting
Print
Config »

Keypad »
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1) Set the Mode to AUTO, then select the country to set the time.

(Time will auto-adjust only if an internet connection is available)

=l

Mode | L J AUTUl MANUAL

Arctic » Shanghai
-

Atlantic v Srednekolymsk

Time oo Australia » Taipsi
Europe » Tashkent
Indian ’ Thilisi
Pacific ’ Tehran
utc Thimphu

2) It is also possible to enter date and time manually by selecting MANUAL Mode.

[ s

Mode AUTO |o MANUAL I

Deta Tima I 2020-08-10 11:18 I g
Arctic , Shanghai

o

Atlantic v Srednekolymsk

Time Zone Australia , Toipei
Europe ’ Tashkent
Indian » Thilisi
Pacific » Tehran
| S

163



CL800O0 Label Printing Scale

3.6.5.1.  Setup - Date Time Format

- You can set the format of the date/time displayed on the screen and the date/time
printed on the label.

CL8000 PROGRAM MODE

Global Settings » Date Time

Print (3 ¢ Date Time Format Setting

Detailed Configuration »

Keypad »

Date Time »

PROGRAM MODE > Setup > Date Time > Date Time Format Setting developer 27-EKM-20 16:51
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1) After setting each value, you can save it by clicking the Save button.

=  Date Time Format Setting

Date Format DAY-MONTH-YEAR

B
Time Format HHMM =
Year Formats. ¥Y_01
Month Format MMM_JAN
Date Separator
Time Separator

# Date Format -> The order of year, month, and day when displaying dates
# Time Format -> Hour, minute, second display format

# Year Format -> Year display format

# Month Format -> Short form of month

# Date Separator -> Date Separator ex) ‘-* => 2020-01-01

# Time Separator -> Time Separatorex) ‘I’ =>12:34
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3.1. DEVICE MENU

x CL8000 PROGRAM MODE

Printer

) rk
Information

Test

Remote Support

Device

PROGRAM MODE > Admin > wd > Display Langusge

3.7.1. Device — Printer

X CL8000 PROGRAM MODE
Network » Sensor Calibration
scale Information » Sensor & Motor
Test Print Intensity
Remote Support Adjust Feed Length

Label Preprint

PROGRAM MODE > Setup > Print > Label Caption 20200914 17:03
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3.7.1.1.  Label Size
- This menu is for configuring label / ticket size.

Width / Height / Gap Length (Length of the gap between the labels)

-> Clicking “Test” button will auto-adjust the size.

= | Label Size

3.7.1.2.  Sensor Calibration

- This menu is for configuring Gap sensor and Peel sensor values.

Click “Start” button to auto-adjust Gap sensor and Peel sensor values.

= | Sensor Calibration

Gop
Poel 149
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3.7.1.3.  Sensor & Motor

- This menu is for turning on / off the sensors and motor.

= Sensor & Motor

Peel-off Sensor ® Yes [ No

Rewind-Moter ® Yes [ ) No S
Out of paper Threshald 200

Label Paper Type Gap

Head-Up Sensor ® Yes [ | No

# Peel-Off Sensor: Use / Disuse Peel-Off Sensor

(Sensor for checking whether the printed label has been collected by a user).

# Rewind Motor: Use / Disuse Rewind Motor

(Rewind Motor does not operate in ticket mode, and the label operates gapless).

# Out of Paper Threshold: Set refill paper threshold.

# Label Paper Type: Set “No Gap” for gapless label, and set “Gap” for label with gap.

# Head-Up Sensor: Can choose to use / disuse Head-Up Sensor

(a sensor for checking open / close status of the printer head).
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3.7.1.4.  Print Intensity

- This menu is for adjusting printing darkness.

You can check the darkness of the printed material by printing CHESS through “Test’

button

= Print Intensity

T

Print Intensity 20

3.7.1.5.  Adjust Feed Length

- This menu is for adjusting label paper.

Enter feed value in between -200 - +200 (Use “Test” button to verify)

=  Adjust Feed Length

B |

Feed Length o
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3.7.1.6.  Label Preprint
- This is the preprint menu (setting preprint area)

# Preprint: Choose whether to use preprint feature.

# Preprint Length: Enter a value between 0 - 10 mm

= Label Preprint

&

3.7.1.7. Reverse Feed

- Configure to allow / prevent Reverse Feed when printing.

Allow Reverse
Fesd(Continuous Label) Yoe (@) No
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3.7.2. Device — Network

3.7.2.1.  Network Setting

- This menu is for configuring network of the scale.

X CL8000 PROGRAM MODE

Printer (77 Network Setting

scalelnfo »

Test

Remote Support

1) LAN card also is configurable.

=  Network Setting

U enp2s0 ()
DHCP / Static DHCP | @ Static
. P 172.16.18.184 ©
Subnet Mask 255.255.255.0
Gateway 172.16.18.254
DNS 1 168.126.63.1
. DNS 2 168.126.63.2
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2) If DHCP is selected, IP, Subnet Mask, Gateway and DNS will be auto-configured.

Press “Save” button.

Network Setting

@ v @
DHCP / Static Static

% whd0374524c5¢9
IP

3) If “Static” is selected, you can manually input IP, Subnet Mask, Gateway and DNS.

Press “Save” button.

= Network Setting
o EN
v oersme | ovcr [0 s |

Y=/ wixd0374521c5c9 B

= 13 172.16.18.184
Subnet Mask 255.265.255.0
Gatoway 172.16.18.264
DNS 1 168.126.83.1
DNS 2 168.126.63.2

i [mmmn T
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4) If a wireless network card is detected, wireless network card option will appear on

= | Network Setting

DHCP / Static @) DHCP Statie

the screen.

QY em2s0 L @

ﬁ wid0374521c5¢9 - _ E
s s
o
v (R
v (S
R —

5) If a wireless network card is detected, list of available wireless networks will be
displayed.
Select a wireless network to access it. If the selected network is password-protected,

you must enter the password to access the network.

w enp2s0 m
DHCP / Static. DHCP (@ Static

= bR @ P 172.16.18.191 g
Wireless Network AP Subnat Mask 255.266.2565.0

nm ﬂ | Gateway 172.16.18.254

SK_WiFigF4D a8 DNS 1 168.126.63.1

AAp a8 DNS 2 168.126.63.2

TEST_2.4G_WEP64 a MAC _

TEST_24G_frea

tsc-P1-2.4G

TEST_2.46_WPA2_TKIP a
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W enplsd I Y

= who4a3857215 d For WIFI access, enter your password
Wireless Network AP PW ‘
un

15c-C1-2.4G

Cen .

3.17.3. Device — Scale Info

3.7.3.1.  Version

- This menu is for checking scale version and checksum value.

X CL8000 PROGRAM MODE

Printer *

Network » License

Scale Information 3 g

Test

Remote Support

Device

PROGRAM MODE > Device > Scale Information > Version 15-10-21 16:09
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1) You can check the scale version and the checksum value.

= | Version
Version Checksum
Main Version 1000008 |
ountry: UN
Additional Information w:r: L;"‘.‘n.nmn |
weighing libcasscale 105
Madule Version Awk3cvazgudT
libcasdisp 105
Printer Module Ver 106 AwISPRIAXZCY
Launcher Version 1.04
00.09 AWK3cV4ZguDT
10008 AwlFur7/vaQa

2020-09-23 1158

# Main Version: Version info of the main software.

# Additional Information: County and mart info.

# Weighing Module Version: Version info of weighing module (checksum exists).
# Printer Module Version: Version info of print module (checksum exists).

# Launcher Version: Version info of software launcher.

# Ul Version: Version info of Ul (screen) (checksum exists).

# Service Version: Version info of Service (functions) (checksum exists).
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3.7.3.2. License

- This menu is to display licence

b 4 CL8000 PROGRAM MODE

Printer Version

Network 7 License

Scale Information ‘

Test

Remote Support

PROGRAM MODE > Device > Scale Information > License 15-10-21 16:08

1) You can check licence information.

Program Name License LD License Memo

Information
The Qt Toolkit is Copyright
C) 2015 The Qt Cor L
QTs6 LGPLV3 @ Qt Gampeny — B
Ltd.Contact:
http:/Awww.gt.ioflicensing/
Copyright© 2021
KoPubA{R|' ¥ KoPubA{X' & veww.kopus.org. All rights
‘KoPubWorld A KoPubWorldA{H|' 2fo| A reserved. Mail to

webmaster

PROGRAM MODE > Device > Scale Inform

15-10-21 16:08
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3.7.4. Device — Test

- This menu is for conducting equipment test.

x CL8000 PROGRAM MODE

Printer
Network

scale

Remate Support

3.741. Test Main Screen

1) Select Language and Type, type in IP, Gap Reference Value and Peel Reference Value,

then press “Start” button to run the comprehensive test (In the order of Display Test -

10 Test).

Click the items on the right to conduct individual tests.

Langusge | English

Type PCA
PASS

8888 FAIL

Ping IP

Referance value for printgr sensor est

perauLT

Gap Reference Value 80

Peal Reference Value 80

Start

1. Display Test

2. Touch Test

3. AD Test

4. Printer Sensor Test

5. Print Test

;
IHE
[ g
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2) Check the results -> Click “Print” button at 10 Test (the last test) to print the results.

10 Test (7/7)

Ethernet

Prev Home Print

- Clicking “Print Result” button in the main screen will also print the results.

=  Test

Language English = 1. Display Test

Type PCA B DEFAULT [ g
pass W 2. Touch Test

Ping IP 8.8.88 FAIL | |

Reference value for printer sensor test 3. AD Test

Gep Reference Value 80

Peel Reference Value 80 4. Printer Sensor Test

5. Print Test

6. Cash Drawer Test

7.10 Test

PROGRAM MODE } Device ) Tost
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- Failed tests are highlighted red, passed green, and pending blue.

Language | English

Type PCA

Ping IP 8888

Gap Refarence Value

Peal Reference Value

Reference value for printer sensor test

60

60

peFauLT [l
rass W
FAIL [ ]

——1

1. Display Test
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3.74.2. Display Test
- This menu is for testing the display.

- Touch the screen to move onto the next screen, where you can proceed with the test.

- Upon completion, press “Pass”. Then click “Next” button to move onto the next test.

Display Test (1/7)

Next
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3.143.

Touch Test

- This menu is for testing screen touch function.

- Upon completion, click “Next” button to move onto the next test.

=

Touch Test (2/7) 6

Press all touch button. Press all touch button.

Touch Test (2/7) 1 Touch Test (2/7)

Press all touch button. Press all touch button.

Touch Test (2/7) 7 Touch Test (2/7)

Press all #2::2h button. Drag from start to stop.
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3.744. AD Test

- This menu is for testing the weighing module.

- Put a weight equal to or greater than 1 kg. If the measurement remains stable for 3
seconds, Pass is displayed.

- Once the test is complete, click “Next” button to move onto the next test menu.

AD Test (3/7)

Stable Count : 3
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3.745. Printer Sensor Test

- This menu is for testing the sensors.

Printer Sensor Test (4/7)

PEEL-OFF Try

HEAD-UP Try

(1) GAP / PEEL Sensor Test

- Click “Cal” button to check Gap Sensor and Peel Sensor values. If no issues are found,
Pass will be displayed.
(2) PEEL-OFF Test

- Click “PEEL-OFF Try” button, then check the PEEL-OFF Sensor.

- Check the PEEL-OFF Sensor as you change its value.
(Bind / unbind the sensor to change the value)

- If the value changes four times within the duration of the test, Pass will be displayed.
(3) HEAD-UP Test

- Click “Head Up Try” button to start the test.

- Move the Head Up Sensor up and down to check for any issues.

- If the values change four times within the duration of the test, Pass will be displayed.
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3.746. Print Test

1) Click “Print Test” button to start the print test.

Print Test (5/7)

Print Test

2) If the test material is printed, click “Pass”; if not, click “Fail”.

Print Test (5/7)

Print Test
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3) Click “Next” to move onto the next test.

Print Test (5/7)

Print Test

3.74.7. Cash Drawer Test

1) Click “Cash Drawer Open” button to test whether the cash drawer opens.

Cash Drawer Test (6/7)

Cash Drawer

Open

Prev Home Next
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2) If the cash drawer opens, click “Pass’; if not, click “Fail”.

Cash Drawer Test (6/7)

Cash Drawer

Open

Prev Home Next

3) Once the open test is complete, proceed to the next test.

Cash Drawer Test (6/7)

Cash Drawer

Open

Prev Home Next
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3.748. 10 Test

1) You can conduct USB ports and Ethernet communications test.

10 Test (7/7)

Ethernet

Prev Home Print

2) Connect to all USB ports, then start the test by pressing “USB Try” button.

10 Test (7/7)

Ethernet

Prev Home Print
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3) Click “Ethernet” button to test Ethernet communications.

10 Test (7/7)

Pass Ethernet

Prev Home Print

4) Once the tests are complete, press “Print” button to print the results.

10 Test (7/7)

Ethernet
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3.1.5. Device — Remote Support

- This menu is for allowing remote access.

(Execute TeamViewer to allow remote access

X CL8000 PROGRAM MODE
Printer
Network

scalelnfo

Test

77 Remote Support

PROGRAM MODE )

1) Click “Start TeamViewer” button to execute TeamViewer.

Remote Support
| Start Team Viewer |

PROGRAM MODE > Dévics
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2) Once TeamViewer starts running, enter ID and the password to remotely control the

scale.

(Exiting the screen will not quit the TeamViewer)

Team Viewer Close

0 Extas Help

«+* Remote Control

Allow Bemate Contral

398 852 390
ws451j

— Remote Support

Control Remote Computer

Partner 1D

 Remote control

Fio vanstor

CONNECT

g Computers & Contacts

20200914 17:45

3) When the remote control session is finished, go back to the TeamViewer screen and

click “Close TeamViewer” to end the remote control (=quit TeamViewer application)

— Remote Support

Start Team Viewer

PROGRAM 3ODE > Device »
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3.8. ADMIN MENU

- Go to Admin menu.

This menu is accessible only when logging in with User level 4 (dealer) or higher.

X CL8000 PROGRAM MODE

Parameter

PROGRAM MODE > Admin > Parameter > Print

10-09-21 14:16

3.8.1. Admin — Parameter
3.8.1.1.  Sale

- This is a setting menu related to sales.

x CL8000 PROGRAM MODE
Parameter »
Language / Keyboard »

Initialization >

PROGRAM MODE > Admin > Parameter > Print dealer

10-09-21 14:16
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1) Set each item.

= sSale

‘Same-Weight product sales
limit range

Allow the weight of the
countipes product

X Key Allowed for Weight
Product

PROGRAM MODE > Admin > Parameter > Sale 10-09-21 11:17

# Same-Weight product sales limits range
- This is the threshold for determining automatic issuance when using Prepack mode.
Automatic issuance is performed when the weight changes beyond the set value.

Only values from (10 to 99) can be saved.

# Allow the weight of the count/pcs product

- At the sales by count PLU, it can be set sales by product even if there is weight on the
scale.

(If set as ‘Yes': sales by product is allowed.)

(If set as ‘No’: sales by product is not allowed.)

# X Key Allowed for Weight Product

- It is a setting as to whether to enable X (multiplication) issuance of weight Product.
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3.8.1.2. Barcode

- This menu for configuration Barcode.

X

CL8000 PROGRAM MODE

Parameter » Sale

.

Initialization

2o Admin

PROGRAM MODE > Admin > Parameter > Barcode

Print
Round
Tare
Weighing
Weight Unit
Communication
Currency
Discount
Display

ad

dealer

10-09-21 11:17

193



CL800O0 Label Printing Scale

1) Set each item.

=  Barcode

Remove barcode last
digit(price)

Remove barcode last
digi(weight)

Remave barcode last
digit(itemCode)

Barcode Date Format

Yes L]

Year-Month-Day

No

PROGRAM MODE > Admin > Parameter > Barcode

dealer 10-09-21 11:17

# Remove barcode last digit(price)

- The cutting position of the price of the barcode

(For the part below the decimal point) (Ex. 3.456 -> 3.4)

# Remove barcode last digit(weight)

- The cutting position of the weight of the barcode =%t

(For the part below the decimal point) (Ex. 3.456 -> 3.4)

# Remove barcode last digit(item code)

- The cutting position of the item code of the barcode (Ex. 12345 ->1234)

# Barcode Date Format

- This is setting for the date format on the barcode
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3.8.1.3. Print

- This menu for configuration Printing.

X CL8000 PROGRAM MODE

Parameter 3 Sale

Languag ard b Barcode
Initialization
Round

Tare

Currency
Discount

Display

PROGRAM MODE > Admin > Parameter > Print

Keypad

1) Set each item.

'

Weighing

Weight Unit

Communication

dealer 10-09-21 11:17

Print Net Weight Symbol Yes @) No
Print Preset Tare Symbol Yes @ No
Print Bitmap CP1252_EUR

Sub Symbol

Label Price Format 100.008

Apply

PROGRAM MODE > Admin > Parameter > Print

- Label Price Format : when the sub symbol doesn't exist

dealer 10-09-21 11:17
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Print Net Weight Symbol Yes (@) No

Print Preset Tare Symbol Yes (®) No a
Print Bitmap CP1252_EUR

=
Label Price Format

PROGRAM MODE > Admin > Parameter > Print dealer 10-09-21 14:33

- Label Price Format : when the sub symbol exist

[ see |

Print Net Weight Symbol Yes @ No

Print Preset Tare Symbol Yes (@) No a8
Print Bitmap CP1252 EUR &

s C o]
Label Price Format 100.008 R

100.00
$100.00
10000 §
$100.00¢

$ 100.00 c(Greek)
$100.00

100.00%
$100.00c
$100.00c(Greek)
PROGRAM MODE > Admin > Parameter > Print dealer 10-09-21 14:33

# Print Net Weight Symbol

- This is the setting of whether to print the unit of weight together when printing the weight field.
# Print Preset Tare Symbol

- This is the setting of whether to print the unit of weight together when printing the tare weight
field.
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# Print Bitmap

-When using CAS Font, you can set the CAS font corresponding the country's code page

# Label Price Format

-You can set the Subsidiary currency unit.

(After entering, dick the Apply button and it will be reflected in the Label Price Format.)

# Label Price Format
- This setting is for the label price format.

(if there is sub symbol, it display more format include Sub symbol.)

3.8.14. Round

- This is the round/down setting menu for Total Price.

x CL8000 PROGRAM MODE

Parameter 3 Sale

ard » Barcode

Print

Tare

Weighing

Weight Unit
(ST

Currency
m .

PROGRAM MODE > Admin > Parameter > Round
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1) Set each item.

Price Round @) Round off Round down
Decimal places 1 R a2
Price Round Apply No Use

PROGRAM MODE > Admin > Parameter > Round dealer 10-09-21 11:17

# Price Round
- round/down
# Decimal places

- Rounding position (Includes the number of digits after the decimal point.)

= | Round

Price Round @ Round off Round down
ER— B
1
Price Round Apply

10

1000

PROGRAM MODE > Admin > Parameter > Round

dealer 10-09-2111:17

# Price Round Apply

- Rounding method. (No Use -No use/ For each PLU - Apply to each product.)
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Round

Price Round @ Round off Round down
Decimal places 1 + S
| Price Round Apply I Na Use
No Use
For each PLU
PROGRAM MODE > Admin > Parameter > Round dealer 10-09-21 11:17

3.8.15. Tare

-This menu is for configuration Tare

X CL8000 PROGRAM MODE

‘ BarCOde

Language / Keyboard » Print

Initialization » Round
T
Weighing
Weight Unit
Communication
Currency
Discount
Display
Management

PROGRAM MODE > Admin > Parameter > Tare dealer 15-10-21 16:14
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3.8.1.6.  Weighing

-This menu is for configuration weighing.

X CL8000 PROGRAM MODE

Parameter » Sale

Barcode

Print

Round

Weight Unit
Communication
Currency

Discount

PROGRAM MODE > Admin > Parameter > Weighing dealer 10-09-21 14:54

1) Set each item.

—] Weighing

Remoave label last
di 0 .

PROGRAM MODE > Admin > Parameter > Weighing 10-09-21 14:54

Bl Remove label last digit(weight)
- The cutting position of the weight Item of the Label

(for the part below the decimal point) (Ex. 3.456 -> 3.4)
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3.8.1.7.  Weight Unit

X CL8000 PROGRAM MODE

Parameter L Sale

Langua Keyboard » Barcode

Initialization » Print
Round
Tare
Weighing
Communication
Currency
Discount

Keypad

PROGRAM MODE > Admin > Parameter > Weight Unit dealer 10-09-21 15:15

3.8.1.8. Communication

- This menu is for configuration communication.

b 4 CL8000 PROGRAM MODE
Language / Keyboard » Barcode
Initialization Print
Round
Tare

Weighing

Weight Unit

¥7 Communication

Currency

Discount
m Display

Keypad

PROGRAM MODE > Admin > Parameter > Communication dealer 10-09-21 15:15
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3.8.1.9.

- This menu is for configuration Currency.

Currency

X

CL8000 PROGRAM MODE

Parameter »

Language / Keyboard »

Initializatio L3

PROGRAM MODE > Admin > Parameter > Currency

Sale
Barcode
Print
Round
Tare
Weighing
Weight Unit
Communication
Discount
Display
Keypad

dealer 10-09-21 15:15

3.8.1.10. Discount

- This menu is for configuration Discount.

x CL8000 PROGRAM MODE

Language / Keyboard »

Initialization »

PROGRAM MODE > Admin > Parameter > Discount

Sale

Barcode

Print

Round

Tare

Weighing

Weight Unit

Communication

Currency
Er=T

Display

Keypad

10-09-21 15:15
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3.8.1.11. Display

- This menu is for configuration Display.

X CL8000 PROGRAM MODE
an rd ¥ Barcode
Initialization » Print
Round
Tare

Weighing

Weight Unit

Communication

Currency

Discount
M‘ ¢ Display

Keypad

PROGRAM MODE > Admin > Parameter > Display dealer 10-09-21 15:15

1) Set each item.

Display price digits 7 .
S
8
9
PROGRAM MODE > Admin > Parameter > Display dealer 10-09-21 15:27

M Display price digits

- You can select the digit displayed on sale screen (7-9 digit, include decimal point)
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3.8.1.12. Keypad

- This menu is for configuration keypad.

X CL8000 PROGRAM MODE

Parameter 13 Sale

Languag yboard » Label Price Format

Initialization Sub Symbol

Price Round
Time Print Format
Separator Sign
Print Symbol

Barcode Date Format
Display
m Print Setting

PROGRAM MODE > Adrmin > Parameter > Print Digit Number Setting W042117:20

3.8.1.13. Management

- This menu is for configuration Management

XX CL8000 PROGRAM MODE
Language / Keyboard » Display
Initialization » Keypad
Menu

EE

Sign

Nutrifact

Korea Traceability

Ticket
m Training

GDPDU

PROGRAM MODE > Admin > Parameter > Management dealer 10-09-21 15:16
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1) Set each item.

=  Management

PROGRAM MODE > Admin > Parameter > Management 10-09-21 15:15

B Logo Login
- You can set whether to log in or not when you move to the program mode using

loge/setting button on sale screen.

3.8.1.14. Menu

- This menu is for configuration Menu

X CL8000 PROGRAM MODE

Ticket
M‘ Training

GDPDU

PROGRAM MODE > Admin > Parameter > Menu dealer 10-09-21 15:16
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1) Set each item.

= | Menu

| Depanment use(Yes/No) Yes (@ No I

PROGRAM MODE > Admin > Parameter > Menu 10-09-21 15:16

B Department use (Yes/No)

- This is the setting for whether to use Department.-You can set whether to log in or

not when you move to the program mode using loge/setting button on sale screen.

3.8.1.15. Report

- This menu is for configuration report

X CL8000 PROGRAM MODE

Language / Keyboard » Display

Initialization ] Keypad
Management
Menu
Sign
Nutrifact
Korea Traceability
Ticket

m Training

GDPDU

PROGRAM MODE > Admin > Parameter > Report dealer 10-09-21 15:16
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3.8.1.16. Sign

- This menu is for configuration sign

X CL8000 PROGRAM MODE

Languag yboard

Initialization »

PROGRAM MODE > Admin > Parameter > Sign

Discount

Display

Keypad
Management
Menu

Report

Nutrifact

Korea Traceability
Ticket

Training

GDPDU

dealer 10-09-21 15:16
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1) Set each item.

Save
1000 Unit Price Separator ®) Unused J(comma) [(dot)
1000 Unit Weight Separator ®) Unused J(commay) .(dot) S
Decimal Point Separator [(comma) @ (dot)
PROGRAM MODE > Admin > Parameter > Sign dealer 10-09-21 15:16

B 1000 Unit Price Separator

- It is a price 1000 unit separator.
H 1000 Unit Weight Separator

- It is a weight 1000 unit separator.

B Decimal Point Separator

- It's a decimal separator.
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3.8.1.17. Nutrifact

- This menu is for configuration Nutrifact

b4 CL8000 PROGRAM MODE

Menu

Report

Sign

Korea Traceability
Ticket

GDPDU

PROGRAM MODE > Admin > Parameter > Nutrifact dealer

1) Set each item.

Nutrifact

| Nutritact Number of decimal I
places.

PROGRAM MODE > Admin > Parameter > Nutrifact dealer 10-09-21 15:16

B Nutrifact Number of decimal places

- This is the decimal point setting of Nutrifact details.
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3.8.1.18. Date Time

- This menu is for configuration date time

X CL8000 PROGRAM MODE

L

Language / Keyboard » Management

Initialization » Menu
Report
Sign
Nutrifact
Korea Traceability
Ticket

Training
GDPDU
m Calibration

PROGRAM MODE > Admin > Parameter > DateTime dealer 10-09-21 15:17

1) Set each item.

[ see |

| Time Print Format 12:34 s |
e
PROGRAM MODE > Admin > Parameter > DateTime dealer 10-08-21 15:17
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=  DateTime
Time Print Format 1234
1234 B
A-Y(0-23)
0-23

10-09-21 16:41

PROGRAM MODE > Admin > Parameter > DateTime

B Decimal Point Separator

- This is the setting for the format when printing the label time.

3.8.2. Admin - Language / Keyboard

3.8.2.1. Display Language

- This menu is for setting the language that is displayed on the scale screen.

X CL8000 PROGRAM MODE

Parameter » 77 Display Language
Language / Keyboard » LGULET

Initialization »

PROGRAM MODE > Atmin > Language | Keyboard > Display Language
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1) Choose the language, then press “Save” button.

Save

Display
Language

PROGRAM MODE > Admin > Language | Keyboard > Display Language dealer

=  Display Language

Korean 320
Russian Pycckait
Chinese H13C

Turkish Tirkge
Latvian Latvie3u valoda
Kazakh xasa Tini

Moldovan Monpgasckuii A3bIk

m

28042117:54

2) You can see that the language has been changed.

HEIW 96 > B2 > 0| 714 > BUEA 90|

b 4 CL8000 T2 B

mf2to|g

olof /7|8 »

%713 »

201220 14:48
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7t

0.000 0.00

n

Max. G/15kg Min.40g e=d=2159 (i) &

3.8.22. Keyboard

- This menu is for configuring the scale’s on-screen keyboard.

X CL8000 PROGRAM MODE

Parameter » Display Language

Language / Keyboard » 17 Keyboard

Initialization

3.8.22.1. Add Keyboard

- You can add on-screen keyboard.
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1) Press “Add” button to show the list of on-screen keyboard.

English =
£
Keyboard
Language
Font Style Style KoPub_Medium

Add Keyboard
Korean Russian
Arabic Ukranian 2
Turkish Dutch
Spanish German
Romanian Bosnian
Hungarian Czech
Polish Chinese
Georgian Armenian
Danish Swedish
Croatian Latvian
Lithuanian Greek
Hebrew Kazakh
-

3) You can set the font for the virtual keyboard. (Applies to all virtual keyboards.)
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TOTALWEIGHING SOLUTION™

T T

English

Russian

Keyboard

Language
Style KoPub_Medium
Style KoPub_Bold
Style Verdana
Style PTFTSF

Font Style Style KoPub_Medium

PROGRAM MODE > Admin > Language | Keyboard > Keyboard

4) Press “Save” button.

English
Russian
Keyboard
Language
Font Style Style KoPub_Medium
PROGRAM MODE >

280421 17:57

- You can check the configured keyboards (pressing Language Change key will change
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the keyboard to the next configured language).

— PLU

T

Namel apple|

Name2 S
Name3
Category Select

Item Code

T B

Save
Namel apple

Name2

Name3

Category Select
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3.8.22.2. Delete Keyboard

- You can delete unused / disused on-screen keyboards.

1) Click “Modify” button.

Keyboard
English =
B

Russian =

Keyboard

Language

Font Style Style KoPub_Medium

PROGRAM MODE > Admin > Language | Keyboard > Keyboard

2) Click the trash can icon to delete an on-screen keyboard.

B T
English i
_ S
Russian m
Keyboard
Language
Font Style Style KoPub_Medium .

L T ———]
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3) Click “Save” button.

Keyboard
Language

Font Style

English

Style KoPub_Medium

PROGRAM MODE > Admin > Language | Keyboard > Keyboard
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3.8.2.2.3. Modify Keyboard

1) You can set the default keyboard layout when using multiple keyboard layouts.

The keyboard language at the top of the list will be the default keyboard layout for the

On-screen keyboard. Click an icon, drag & drop it to move keyboard of the selected

language up or down on the list.

T

al

Russian =

Language

Font Style Style KoPub_Medium

2) You can set to other keyboard layouts by clicking their icon.

=  Keyboard
English =
Russian = | Us English + Cyrillic
United States-Dvorak
United States-Dvorak left
Keyboard
Language
United States-Dvorak right
United States-International
Font Style Style KoPub_Medium
e L e ——— eale 3811800
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3) Click “Save” button.

English = us
S
Russian = US English + Cyrillic
United States-Dvorak
United States-Dvorak left
Keyboard
Language
United States-Dvorak right
United States-International
Font Style Style KaPub_Medium
PROGRAM MODE > Admin > ar aeaier sz 1800

4) You can see that the keyboard layout has been changed.
If Russian keyboard is set to top, language of virtual keyboard will be set to Russian.
(You can also use other keyboard layouts by pressing the language change key right next

to the Space key)

=  Depariment
[ see ] o oo |
Deparment

No. 1

Department Name Defaulf g
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3.8.3. Admin - Initialization

38.3.1. Mart

- This is the menu to proceed with the initialization.

X CL8000 PROGRAM MODE

Paramet

Initialization »

1) Click the ‘Mart Initialization’ button

Mart Initialization
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2) When the notification window pops up, click the “OK” button.

Mart

Are you sure you're running a mart
initialization?

3) Select the SALE MODE and the Mart to install and click the “Next” button

Country & Mart Initialization

Please select a mart
Country
SALE MODE © AssisTmope | @ SELF MODE

STANDARD_10inch

STANDARD_15inch
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Country & Mart Initialization

Please select a mart

Country

SALE MODE © stLF mMopE

STANDARD_NORMAL

STANDARD_NUMERIC

# ASSIST MODE — The way the clerk sells it.

# SELF MODE — The way consumers buy it themselves.

4) After setting the time, click the “Apply” button.

Country & Mart Initialization

Please select a time zone.

Mode 0o @
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5) Press the “OK” button to initialize. When initialization is complete, it reboots.

If you change the settings, The balance will
restart.

Would you like to proceed?

6) It is initialized to the selected mart.
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kg  WEIGHT ko

UNIT PRICE $/kg ~ TOTAL PRICE %

0.000 0.000 0.00 0.00 ,

Choose Item

>0< TARE DISC{:) DISC{%)

AUTO SAVE ADD STTTL

OVER PRE

FOR  pipe  pack PLY

11

Max. 6/15kg Min. 40g e=d=2i5g (D) ¥/
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4. TROUBLESHOOTING

1. Communications Issue

Can’t access the LAN

= Check the hub or the switch

= Check the RJ45 network cable
= Check the LAN LED

= Reinstall the LAN card

= Replace the mainboard

2. USB Issues

I

USB port does not work

= Check the status of plugged devices in the windows’ Device
Manager

= Check USB device status and connectivity

* Remove and reinstall the USB driver

= Change the USB device

3. Display Issues

LED backlight does not work

= Check the display cable

= Check the inverter cable

= Replace the inverter cable
= Replace the display panel
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4. Touchscreen Issues

= Check the BIOS configuration
= Check the mainboard and the LCD cable
= Recheck the BIOS configuration

Touchscreen does not sense
tactile input

5. Power Issues

= Check the A/C cable

= Check the mainboard power

* Check the CPU configuration/status

= Check the system memory configuration
= Check the power button cable

= Replace the adapter device

System does not load
following a sudden
shutdown

6. Booting Issues

Reboot during system = Check the SATA cable
operation = Check the memory status

1. Reading Issues

Weight reading does not = Check the RS232C cable
appear = Check the installed folder

227



CL800O0 Label Printing Scale

228



http://www.globalcas.com

Label Printing Scale User Manual

CLSOOO Series

96885CLHBB330

s LIEINAT

[=]

9005-CLH-0033-0  2020.09

CAS BLDG., 1315, YANGJAE-DAERQ,
GANGDONG-GU, SEOUL, KOREA

TEL_82222253500
FAX_8224754668
Specifications are subject to change without notice improvement. Y/ A\




